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1 Introduction 

These training notes provide a reference during and following Civica Education’s Timetabling 
Construction training. During training, we will be working with fictitious data and all the exercises 
contained within these notes refer to that data.  
 
The training is designed to start with an overview of the Administration Manager, to provide an 
understanding of the links between Administration Manager and Timetabling.  The training will then 
progress through the functions and features of the Timetabling module. The Timetabling Manual 
provides a comprehensive guide to the software. 
 

1.1 What is Administration Manager? 

Administration Manager is a Windows-based database that enables schools to keep detailed 
student and staff records and use these records to produce a wide range of reports.  Student data 
is stored in three main data sections – Admissions, Current Roll and Former Roll.  Each student 
record is divided into several sections such as personal, address, activities and medical details.  
There is also an Emergency feature for fast access to student data. 
 
Other functions include Speed Edit, Control functions, the Year End function, Admissions, and 
Standard and Ad Hoc Reports. 
 
The system is easy to use and maintain.  Administration Manager is a powerful tool that gives 
administrators smooth access to information, ease of use and a well-structured, logical layout. 
 

1.2 What is the Timetabling Module? 

The Timetabling module assists schools to produce and maintain a comprehensive timetable of 
teaching and learning programs using the information entered in the Administration and 
Timetabling modules. The system provides a comprehensive set of tools to manage the entry of 
student subject preferences, construction of grids, creation of school timetables and management 
of student courses and resource allocation.  
 
The Timetabling module is one component of a suite of modules that comprise the School 
Information System.  The Timetable module both draws information from and provides information 
to the other SIS modules. 
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1.3 Timetable Training Program 

Day 1 

 

8.45 am Coffee 

9.00 am Welcome 
Introductions 

9.15 am Logging On 

Administration Manager  

Timetabling Terminology and Concepts 

Review:  Timetabling Maintenance 

 Course Change Recording 

 Department Colours 

 Student Course Maintenance 

 Staff and Room Maintenance 

10.30 am Morning Tea 

10.50 am Review: Timetabling Maintenance 

 Grid Modelling 

Creating a New School Year 

Defining Timetabling Periods 

Creating Campuses  

12.30 pm Lunch 

1.10 pm Timetabling Parameters  

Timetable Set Up 
 Accessing Campuses  
 Creating Cohorts  

 Staff Preferred Subjects and Rooms 
 Subject Preferred Rooms  

 Course Promotion Table 
 Period Types  

 Department Colours 

 Subject Relationship Table 

 Data Entry 

Creating A Cycle 
 Master Period Structure 
 Allocating Staff to a Cycle 
 Allocating Rooms to a Cycle  

2.40 pm Afternoon Tea 

3.00 pm Review and Questions 
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Day 2 

 

8:45 am Coffee 

9:00 am Defining Grids 
 Cohorts 
 Period Structure 
 Subjects and Subject Groups  

 Rooms 
 Staff  
 Band Allocation  

Student Preferences 
 Individual Entry 
 Bulk Entry 
 Promoting Courses 

Data Validation Reports 

10.30 am Morning Tea 

10.50 am Subject Load Table  

Grid Modelling 
 Creating a Fixed Grid 
 Inter-Grid Linkage  
 Time Slot Mapping 

 Grid Constraints 
 Auto-Scheduling  

12.30 pm Lunch 

1.10 pm Grid Modelling 
 Fitting Unplaced Students 
 Balancing Sets 
 Conflict Resolution 
 Re-assigning Student Courses 
 Saving the Grid to the Timetable 

Allocating Staff and Rooms 
 Manual Allocation 
 Auto-Allocation 

Timetabling Reports  

2.40 pm Afternoon Tea 

3.00 pm Review and Questions 
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1.4 Training Outcomes 

At the end of the timetabling training program, you will be able to: 
 

• Navigate your way through the sidebar options in the General and Timetabling modules of 
Integris 

• Use Timetabling Help 

• View and find school, student and staff records 

• Locate, add and edit timetabling parameters 

• Create a timetable model 

• Create, edit and delete a timetable cycle 

• Define timetable cycle properties 

• Create a grid and define the grid properties 

• Enter student preferences individually and in bulk 

• Model a grid manually and use the auto-scheduler  

• Manipulate a timetable manually 

• Allocate staff and rooms to a created timetable 

• Produce standard timetable reports 
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2 Logging On 

ACTIVITY 

 

• Double click on the Integris icon on your desktop. 
 

 
 

• Type ADMIN into the User Name field 

• Press <Tab>  

• Type KEYS into the Password field 
 

 
 

• Click on Login or press <Enter> 
 

Note: In schools, each user has his or her user name and password, which enables access 
to particular sections of the software as determined by the school administration. 

It is strongly recommended that you change your password once the software is installed in 
your school and once a month thereafter. 
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2.1 The File Menu 

The file menu may be accessed by clicking on File in the top left of your screen. 
 
Password enables the user to change his or her password.  For security purposes, it is 
recommended that this be done regularly. 
 
Change User should be used to ensure that each person accessing Integris does so under their 
own user name and with their personal levels of access. 
 
Lock Terminal may be used if the user needs to leave his or her computer temporarily, does not 
want to log off and does not want to allow access to anyone else.  Unlocking the terminal requires 
the user to enter his or her password again 
 
Report Destination allows the user to choose where to send any report created in Integris.  The 
options are displayed below. 
 

 
 

ACTIVITY 

Top Toolbar > File 

• View each of the following items in the File menu 
o Password 
o Change User 
o Lock Terminal 
o Report Destination 
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2.2 Accessing Help 

ACTIVITY 

Top Toolbar > Help > Help Contents and Index 

• Click Help in the top toolbar 

• Select Help Contents and Index 
 

 
 

• Highlight Integris Time Help 

• Click Help 

• View the Timetabling manual  

• Close the manual and Help 
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3 Introduction to Administration Manager 

Administration Manager comprising of the Admin and General modules is the basis of the Integris 
software.  Users of the Timetabling module will need to be aware of particular functions within the 
Administration Manager to be able to work effectively in the Timetabling module.  
 
The functions or sections that timetablers should be familiar with are  

• School Details 

• Student Details  

• Staff Details 
 
Other areas that should be investigated are certain parameters that also impact on the timetabling 
process.  These are:  

• Departments 

• Room Type 

• Rooms 

• Subjects 

• Subject Classification 

• Subject Type  
 
All of these functions and parameters will be discussed in greater depth over the next few pages. 
 
This section only covers functions that are integral or necessary for a timetable to be created and 
maintained.  If more information is required regarding other functions, attending the Administration 
Manager training program is recommended. 
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3.1 Staff Details 

General > Staff Details 

Administration Manager can hold details on both students and staff.  The staffing section of the 
system is accessed via the Staff Details icon on the General side bar.  Functionally it is very similar 
to the student window, using many of the same icons. 
 

3.1.1 Entering Staff Details 

To add a new member of staff click Add.   The following window will appear, enabling users to 
enter the relevant information.   
 

 
 
Mandatory fields are: 

• Surname 

• First Name 

• Gender 

• Date of Birth 

• ID Number 

• Staff Code 
 
It is also good practice to include:  

• Title 

• Staff Type 

• TRBWA number for teachers (on the UDI tab) 
 

To edit  a staff member’s details, display their record by either scrolling through or using the 
Find facility and then click on the Edit icon.  
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ACTIVITY  

General > Staff Details 

• Click Add   

• Enter the following information about yourself, tabbing between the fields: 
o Title 
o Surname * 
o First Name * 
o Gender 
o Date of Birth * 
o Staff Code * (first three letters of your surname and your first initial) 
o ID Number 
o Staff Type  
o TRBWA number (on the UDI tab) 

Note:  * indicates the field is mandatory 
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3.1.2 Making a new staff member available to the timetable 

ACTIVITY 

Timetabling > Timetable Setup >Timetable Cycles 

• Click on the Staff Availability tab 
 

  
 

 

• Click Add Staff Members  

• Enter the first three letters of your surname in the Name/Number field and click Find 
 

 
 

• If necessary, highlight your name in the list and click Select 
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Edit your net FTE 

• Ensure your name is highlighted 

• Click Non-teaching Activities  

• Click Edit  

• Enter a Code, Description and FTE 
 

 
 

• Click OK, Yes and Close 

• Close Timetable Cycles and Timetable Setup 
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3.2 Student Details 

General > Student Details 

Student Details display comprehensive information about each student attending the school.  From 
the General side bar, choose Student Details.  The following window will appear: 
 

 
 
This is the summary window and displays the basic student data and a photograph of the student 
(where available).   

Photos are accessed by clicking on Display Student Photograph  at the bottom right-hand 
corner of the window. 
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Student Details Toolbar 

 
 
This drop-down menu enables the user to decide which of the rolls they wish to view: the 
Admissions Roll, Current Roll, Former Roll or the External Roll. 
 

  The Next Student and Previous Student arrows on either side of the binoculars allow 
you to scroll through the database either forward or backward in alphabetical order.  

  The Find Student tool enables users to find individual students or groups of students based 
on selected criteria.  
 
To view specific areas of a student’s record, use the buttons on the tool bar at the top of the 
Student window: 
 

  Add a new student  

  Edit student data 

  Move a student to the Former Roll 

  Print student details  

  Send a letter 

 Send an e-mail  

  Summary details 

  Additional details 

  Movement History 

  Attendance History  

  Groups 

  Student Activity  

  User-defined Information 

  Medical Details 

  Teaching Sets  

  Miscellaneous details 

  Student timetable 

  Cohorts 
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Student Status Bar  

 
 
The Student Status Bar is designed to be visible from all panes of the window, giving users a view 
of key student indicators at a glance. 
 
The Status Bar is split into two sections, with the left-hand section reserved for data that are more 
sensitive.  In both sections, information on the current student is displayed using icons.  Hover the 
pointer over an icon and it will display a description of its meaning. 
 

Normal Bar 

 Student has a flagged medical condition 

 Language Background other than English 

 Access restriction 

 Part-time student 

 Accepted (Admissions Roll) 

 Student Notes 

 Name Change 
 

Sensitive Status Bar 

 Educational Support Program 

 Excluded (Former Roll) 
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3.2.1 Moving a Student to the Former Roll 

General > Student Details > Move Student to Former Roll  

If a student is moved to the former roll, and Timetabling is installed, the following window will be 
displayed: 
 

 
 
Typically, schools will want to remove timetabled students from cohorts or they will continue to be 
displayed on teaching set lists (although marked as left).  There are two ways to remove students 
from cohorts in this window: 
 

• Highlighting the cohort(s) displayed in the Member Of pane and clicking Remove 

• Clicking  Remove from all Current and Future Cohorts 
 

The second option  Remove from all Current and Future Cohorts is recommended, as this 
will enable the option to keep a record on the student’s preferences and teaching sets. 
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ACTIVITY 

General > Student Details 

• Click Next Student  to load Adam Alkitik’s records 

• Click Move Student to Former Roll   
 

 
 

• Click Yes 

• Enter his Leave Date as TODAY, his Destination Northern Territory and his Reason for 
Leaving as Interstate 

 

 
 

• Click OK 

• Click Yes, you do want to move the student from his groups 

• Click OK to the default date for changing the roll status 

Note: Daily records for Lesson Attendance have been created until almost the end of the 
term for training purposes.  In schools, daily records should be created daily.  
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• Click  Remove from all Current and Future Cohorts 

• Click Yes, you do wish to save a record of the student’s teaching sets 

• Close Student Details 
 

Note: Using Remove from all Current and Future Cohorts, instead of Remove, gives users 
the option to create a record of the leaving student’s current subjects and teaching sets. 

 

3.3 Parameters 

General > Parameters  

Parameters enable the user to define a list of acceptable options that will be available when data is 
entered.  Appropriate use of parameters will enable the timetabler to search, sort and print data 
relevant to the school’s structure.  It is recommended that parameters are locked once they are 
set. 
 
The following parameters will be useful to the Timetabling Module.  Secondary schools may need 
to set up some or all of the parameters below, depending on the structure of each school and other 
factors, for example migrated data. 
 
Departments provide a secondary organizer for school activity and can be physical or logical 
entities.  Departments can be linked to a faculty but the use of faculties is not mandatory.  For 
example, an Arts faculty may contain Art and Drama departments.  This is a mandatory 
parameter for timetabling purposes. 
 
Room Types define the different categories of rooms available in the school, for example Science 
Labs, Art rooms, Classrooms etc.  These rooms can be linked to specific subjects.  While the 
Room Types parameter is not mandatory for timetabling, it is very useful and users are 
recommended to take advantage of it. 
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Rooms define the actual individual rooms available within the school.  The user must enter in all 
rooms of the school if rooms are to be listed on the timetable.  This is a mandatory parameter for 
timetabling purposes. 
 
Subject Classifications are ways of classifying subjects for the School Curriculum and Standards 
Authority.   
 

 
 
While this parameter is not mandatory for timetabling, it is essential for reporting to the School 
Curriculum and Standards Authority. 
 
Subject Types are ways of identifying subjects for School Curriculum and Standards Authority   
 

 
 
While this parameter is not mandatory for timetabling, it is essential for reporting to the School 
Curriculum and Standards Authority. 
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Note: Only subjects with the type ATAR, General, VETCOS or CEP will be included when 
reporting to the School Curriculum and Standards Authority.   

 
Subjects may define an individual subject, for example English, or the components of courses 
offered by the school.  They will contain the default values such as class size, frequency etc.  This 
is a mandatory parameter for timetabling purposes.  
 

 
 
It may not be necessary to use all of the fields for all subjects.  Fields that should be entered are: 

• Subject Name 

• Subject Code 

Note: For School Curriculum and Standards Authority accredited subjects the Code must 
be the Unit code. 

• Short Name 

Note: For School Curriculum and Standards Authority accredited subjects the short Name 
must be the three-digit Course code. 

• Department, which will also load Faculty and Department Head if these have been entered in 
Department 

• Frequency 

• Maximum Class Size 
 
For School Curriculum and Standards Authority accredited subjects, other necessary fields are: 

• Subject Type 
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Note: Only subjects with the type COS, VETCOS or CEP will be included when reporting to 
the School Curriculum and Standards Authority.   

• Subject Classification 

• Moderating Teacher (Contact Teacher in the Subject Register) 
 
Timetabling defaults should be entered here.  They can be edited in the Timetabling module but 
global parameters are entered here. 
 
All Parameters may be added or edited, printed, locked, made active or inactive and/or made the 
default parameter. 
 
The parameters to be created need to be set up in the preceding sequence.  
 
 

ACTIVITY  

General > Parameters > Room Type 

The school has recently acquired a Performing Arts Centre.  Enter as a new room type. 
 

• Right click on the yellow pane 

• Select Add/Edit Parameters 

• Enter a Code and Description 
 

 
 

• Click OK  

• Highlight Performing Arts and Lock  

• Close the Room Types screen 
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Add two Performing Arts rooms. 

General > Parameters > Rooms  

• Click Add  

• Enter the following details and click OK 
 

 
 

• Highlight DI and click Copy  

• Enter details for D2 

• Close 
 

General > Parameters > Subject Type 

• Click Modify Parameters  

• Enter the additional parameters 
 

 
 

• Click OK and close 

Note: Only subjects with the type ATAR, General, VETCOS or CEP will be included when 
reporting to the School Curriculum and Standards Authority.   
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General > Parameters > Subject Classification  

• View the parameters 
 

 
 

General > Parameters > Subjects 

• Edit  ATLIT to show AELIT as the prerequisite 

• Add yourself as the Moderating Teacher 
 

 
 

• Click OK 
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4 Introduction to the Timetabling Module 

The Timetabling Module must perform two important functions.  It must facilitate the creation of a 
timetable, which satisfies the educational requirements of the school, and provide an environment 
for the efficient day-to-day maintenance of the timetable. 
 
This course will examine the functions available for the maintenance for an existing timetable and 
then look at the processes required to construct a timetable. 
 

4.1 Using the Timetabling Sidebar 

The Timetabling sidebar allows users to set up, create and maintain the school’s timetable for 
current and future years.  
 

 

 
 
Student Course displays for each student a list of preferences, the 
student’s timetable and the relevant grid for the student with his or her 
teaching sets highlighted. 
 
Timetable displays the current whole school timetable that may be filtered 
by year, cycle, schedule, grid or department. 
 
 
Grid Modelling allows the user to either manually manipulate the grid or 
define constraints and use the auto-scheduler to model the grid or a 
combination of both. 
 
Preferences refers to the entry of student’s subject preferences which may 
be entered either on an individual or group basis. 
 
 
Reports allows the user to access a list of timetable reports divided into 
three main areas: Data Validation Reports, Planning and Preparation 
Reports and Operational and Maintenance Reports. 
 
Timetable Set-up allows the user to define all aspects of the timetable prior 
to creation of a new timetable. Timetable set up can be completed at any 
time for future timetables. 
 
 
Data Entry allows the user to make future Subject recommendations for 
existing students. 
 
 
Exam Scheduler opens the Exam Scheduler module. 
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4.2 Timetabling Terminology and Concepts 

The TIMETABLE is a tool that enables the resource needs of the school to be managed. A 
school’s timetable is a plan of the student’s time, which indicates the subject being studied, its 
location, the teacher taking the class and the frequency of the subject. The subject choices of 
students need to be satisfied within the constraints imposed by the limited resources of teachers 
and rooms. 
 
The TIMETABLING YEAR holds all of the school’s timetabling activity within the school year.  
Integris will store past, present and future timetables enabling users to move between timetables. 
Within a timetable year, a CYCLE contains information regarding Cycle dates and period 
structures drawn from the school calendar and connects with the Lesson Attendance module.  
Cycles can be defined for each logical or physical CAMPUS. Students grouped together for 
timetabling reasons are identified as a COHORT and students may belong to multiple cohorts. 
 
GRIDS are the focus of timetabling activity and can be created or cloned from previous years. All 
Staff, rooms and subjects can be made available or unavailable, where required, to a grid.  The 
grid provides the framework within which the teaching sets required to satisfy the selections of 
students within the grid will be placed. 
 
Grids are made up of BANDS, which are similar to gridlines, but are divided up into BAND 
RECORDS.  Band records can be individually manipulated and ultimately represent a single 
occurrence of that combination of teaching sets on the timetable. 
 
Student PREFERENCES (subject selections), as well as reserve preferences, may be allocated, 
individually or in bulk, selected from groups or promoted from the previous year. 
 
Grids may be created manually or by using the AUTO-SCHEDULER or using a combination of the 
two to add some fixed elements.  The auto-scheduler can take into account a wide range of 
constraints when determining the optimal solution. 
 
Grid manipulation is referred to as MODELLING, and a comprehensive set of tools is available to 
assist with the modelling process from horizontal and vertical representations of the grid.  
Modelling can be used to construct a grid manually, as in Fixed Grid schools or to manipulate the 
output from the auto-scheduler. 
 
Grids are assigned to one or more SCHEDULES.  Schedules have a defined period of activity and 
a TIMETABLE will be a combination of all events active at a particular time.  
 
Each period of time for which the timetable remains unchanged is known as a TIMESLICE.  The 
timeslices required by the timetable are calculated automatically by the system by examining each 
of the schedules linked to grids. 
 
The timetable applicable to any date during the year can be selected by choosing the appropriate 
timeslice from a list of date ranges provided. 
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5 Review: Timetable Maintenance 

Once the timetable has been created, it may be necessary over its life to make changes.  The 
changes may take the form of staff and/or student movement, new subjects and/or old subjects 
being dropped, and rooms may become available and/or unavailable for a variety of reasons.  The 
timetabling module is flexible enough to be able to take these changes into account in an operating 
timetable. 
 
Maintaining the timetable has been broken into three areas to make it easier for the user to follow 
the necessary steps: 

• Student Course Maintenance 

• Staff and Room Maintenance 

• Grid Changes 
 

5.1 Course Change Recording 

Timetabling > Timetable Set-up > Set Course Change Recording for all Students 

It is possible to turn on, or off, Course Change Recording for all students for an entire year. 

Note: It is recommended that Course Change Recording is not turned on globally until all 
grids for a given year are completed. 

Course Change Recording may also be turned on or off for individual students in Student Course. 
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ACTIVITY  

Timetabling > Timetable Set-up > Set Course Change Recording for all Students 

• Click Edit Course Recording Change Default  

• Select ON 
 

 
 

• Click OK 

• When finished, Close 
 

Note: It is recommended that Course Change Recording is not turned on globally until all 
grids for a given year are completed.  Course Change Recording may also be turned on or 
off for individual students in Student Course.  
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5.2 Department Colours 

Users have the ability to identify Departments with colour to simplify the identification of the location 
of Teaching Sets on the grid.  Once assigned, these colours will appear wherever a grid view is 
available, that is in Student Course, Grid Modelling and in reports showing the grid.  
 

ACTIVITY 

Timetabling > Timetable Set-up > Department Colours 

 
 

• Highlight Home Economics and click Edit Details 
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• Select a colour and click OK 

• Repeat for the Art department 

• Click OK to close 
 

Note: The colours may be turned off by clicking Clear Colour Scheme.  
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5.3 Student Course Maintenance 

Timetabling > Student Course 

There are a number of reasons to update the timetable once it has been produced: 

• New students may enrol during the school year and need to be entered onto the timetable  

• Students may leave the school and may be deleted from the timetable 

• Students may alter their courses after the new timetable is operating 

• New subjects may be introduced and students may wish to change their course to take the new 
subject 

• Teaching Sets may be split or collapsed and students will need to alter their course 
 
Student course maintenance functions are performed within the Student Course sidebar.  The 
course for each student is presented in three views. These are: 

• Preferences 

• Timetable  

• Grid  
 
Each view will allow the entry and editing of the student’s course and will have advantages in 
different circumstances. The Timetable view will only be available when the grid of which the 
student is a member has been saved to the timetable. 
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Preferences View 

The Preference view lists the teaching sets that the student has been allocated to and the grid 
bands where these have been placed.  Any preference that has not been assigned to a teaching 
set will be highlighted in red and have NO in the Assign column. 
 

 
 

Deleting Preferences 

• Highlight the appropriate preference and click on Delete  

• Confirm your selection 
 

Adding Preferences 

Preferences can be added by dragging and dropping from the subject selector or by keyboard 
entry. 
 
To use the subject selector: 
 

• Click on  

• Click and drag the desired preference from the Subjects table and drop into the white area of 
the preference window 
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Allocating/Promoting Reserve Preferences 

• Highlight the appropriate Preference 

• Click on the Toggle button  

• Confirm your action.  
 

 
 

Fitting the Student into existing Teaching Sets 

• Highlight the unassigned preference 

• Click on Assign Teaching Set   

• Select a Teaching Set and click OK 
 

 
 

Note: If the teaching set cannot be assigned due to a conflict, a warning message will be 
displayed. 
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Alternatively, Suggested Student Fit button  may be used.  The following screen will be 
displayed. 
 

 
 
The suggested fit may be saved or discarded. 
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Timetable View 

The Timetable view displays the selected student’s course within the grid and timeslice selected.  
 

 
 
Right clicking on a period presents a number of options to manipulate the student’s course.  These 
options are: 

• Show Teaching Set Members 

• Show Available Sets – presents alternate teaching sets available at this time 

• Remove Student – removes the student from the set 

Note: Changing a student to a new subject within the timetable view does not delete the 
original subject.  If necessary, this can be deleted or marked as a reserve in the preference 
view. 
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Grid View 

 
 
Grid view presents the selected students course overlayed onto the grid.  Right clicking on a 
populated cell enables the student to be removed or moved to an alternate teaching set.  A band or 
band record to which the student is not fitted is highlighted and the student can be added to a 
selected teaching set. 
 
The Move Student function will display a window that will allow users to move the student 
between teaching sets on the same band or remove the student from their current teaching set by 
clicking on the Drop Student out of this Teaching Set button. 
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Note: Changing a student to a new subject within the grid view does not delete the original 
subject.  If necessary, this can be deleted or marked as a reserve in the preference view. 

 

New Students 

As new students are added to Integris, the user will be prompted to include the student in an 
existing cohort.  The user must include the student in at least one cohort to add the student to the 
timetable.  Once the student has been entered into the cohort, the student must be assigned 
subject preferences.  Preferences may be entered in one of two places: Timetabling > Preferences 
or Timetabling > Student Course. 
 
The Student Course window displays the student’s subject preferences, their individual timetable 
and the relevant grid with the student’s teaching sets highlighted.  Selecting Student Courses 
from the Timetabling sidebar will display the Student Course Maintenance window. 
 
For a new student the preference screen will be blank and subject preferences may be entered in 
the same way as described earlier. 
 
After the preferences have been added the student must be added to existing teaching sets. This 
may be done in one of two ways: 
 

• Manually, by highlighting the subject, clicking the Place in T-Set button  and selecting the 
appropriate teaching set from the list displayed 
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• Automatically, using Generate Suggested Fit icon  from the Student Course screen, this will 
place the student in acceptable teaching sets if it can do so without clashes   

 
Once the student has been added in either way to teaching sets, the student will now have a 
timetable which will be shown in Timetabling > Student Course > Timetable. 
 
A student’s course may also be entered within the Grid or Timetable views.  
 

Leaving Students 

Students who leave the school may be removed from the current timetable.  Moving a student to 
the former roll will prompt the user to remove the student from any cohorts.  Once students are 
removed from their cohorts, they are removed from the timetable.  Users do have an option to 
leave student in their current cohorts and they will remain in their teaching sets but will be 
displayed in red to show they are no longer current students. 
 

Change of Course 

Students may alter their subject selections after the current timetable has begun operating.  The 
student must be deleted from current teaching sets and their preferences must be altered to reflect 
their new course.  The student then needs to be placed in the new teaching sets as discussed 
above for new students. 
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ACTIVITY  

Timetabling > Student Course 

• Use Search to locate Ben Anderson’s records   

• View his course on the Preferences tab   
 

 
 

• Select the Timetable tab 

• Print   Ben’s timetable to the screen 
 

 

• Select the Grid tab 

• Click Toggle Student Placement/Department Colour  
 

 
 
Colours have been assigned to the Art, D&T and Home Economics departments. The text and 
background colour vary according to whether or not the student is in the class.  Ben is in 10Food_2 
and 10Art_1. 
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Todd Virgil is a new student and has been added to the Year 10 cohort.  Enter his 
preferences. 

• Find Todd Virgil’s records  

• View his course on the Preferences tab   

• Click Show / Hide Subject List 
 

 
 

• Drag and drop the Subject Group 10REQ onto the white screen 

Auto-allocate Todd to his required class. 

• Click on Generate Suggested Fit    

• Click OK to save and accept the suggested fit 

• Close the Move Student window 
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• Click on the Grid tab 
 
Each of the grid bands where Todd does not have preferences are highlighted in red. 
 

• Right click in the red cell containing 10Ind_1 and click Add Student and Yes 
 

 
 

• Continue to add Todd to teaching sets on the remaining grid bands 

Note: we will be splitting the oversized class later. 

• Click on the Timetable tab and view Todd’s timetable 

• Print  Todd’s timetable to the screen 
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Course change in grid and timetable views 

Jonathon Depete is moving from Food Production to Metalwork. 

• Find Jonathon Depete’s records   

• Click on the Grid tab 

• Right click in Jonathon’s Food class on Band 10 and click Move Student 

• Select 10MW_1 and click OK 
 

 
 

• Click on View/Print Course Change History  and print to the screen   
 

 

• Click on the Preferences tab 

• Highlight 10Food and Delete  
 

 
 

• Close Student Course 
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Note: When students change courses, it is important to toggle to reserve or delete the 
subject that they have dropped otherwise they will be billed for both the old and new 
subject. 

 

5.4 Staff and Room Maintenance 

Timetabling > Timetable 

 
 

The timetable is displayed in grid order with spaces between the grids.  Clicking  will reverse 
the order of the grids. 
 
Maintenance of Staff and Room timetables may be necessary from time to time due to staff 
turnover or leave and/or the addition or restricted use of rooms for whatever reason.  
 
Allocation and maintenance of staff and room details is performed within the Timetable.  Selection 
of this function will open the timetable that applies to the current date.  The timetabling year and 
timeslice can be selected to view the timetable to be staffed and roomed. 
 
Only grids that have been saved as timetable will be visible. 
 

 

Timeslice 

Timetabling Year 
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The Period Summary view provides a period-by-period view of the total timetable activity. 
 
The appropriate component of the timetable is selected using the Timetabling Year and Timeslice 
selections. 
 
The Timeslice is calculated by the system following examination of grids and schedules as a period 
that the timetable will operate unchanged. 
 
The Period Summary view can be filtered to show activities associated with an individual grid or 
subjects linked to a department 
 

Manual Placement or Editing of Staff and Rooms 

Manual placement or editing of teaching staff and rooms are allocated by highlighting an 
appropriate teaching set, right clicking and selecting from the list of functions. 
 

 
 

Note:  Show/Add User Defined Period times enables the user to enter or view period times 
for the selected teaching set that are different to those entered in the Master Period 
Structure. 

 

Switch View 

The Switch View function enables the timetable for a teacher and room to be displayed. 
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5.4.1 Cloning Resources from One Schedule to Another 

ACTIVITY 

Timetabling > Timetable 

 
 

The timetable is displayed in grid order with spaces between the grids.  Clicking  will reverse 
the order of the grids. 
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• Filter to the Year 8 grid and Term 4 
 

 
 

• Click Functions > Clone Resource Allocation 
 

 
 

• Read the text and click OK 
 

 
 

• Check Clone Staff Resource Allocation and Clone Resource Room Allocation  

• Click OK  
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• Select to clone from Term 3 

• Click OK  
 

 
 

• Click OK 

Note: Staff and Rooms will only be copied from one Timeslice to another for Teaching Sets 
with identical codes scheduled at exactly the same time. 
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5.4.2 Allocating Teachers & Rooms 

ACTIVITY  

Timetabling > Timetable 

• Scroll down to Wednesday Lesson 1 
 

 
 

• Right click in the first cell and select Allocate Teacher 

• Select Allocate Staff Member to ALL Class Meetings for the Teaching Set and click OK 
 

 
 

• Select a teacher and click OK 

• Right click in the same cell again and select Allocate Room 

• Choose Allocate Room to ALL Class Meetings for the Teaching Set and click OK 
 

 
 

• Select a room and click OK 

• Repeat for the other teaching sets on at that time 

Note:  If a teacher has a preferred room, then the room will be allocated to the teaching set 
at the same time as the teacher. 
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5.4.3 Changing Teachers & Rooms 

ACTIVITY  

Timetabling > Timetable 

• Filter to the Year 10 grid  
 

 
 

• Filter to the English department 
 

 
 

• View All of the English classes 
 

 
 

• Click Switch View and select Timetable View  

• Find  Harris Barclay’s timetable 

• Select Room Timetable 

• Find  one of the Science classes 

• Click Switch View and return to Period Summary View 
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Harris Barclay is going on long service leave.  Allocate a suitable member of staff to take 
his classes. 

• Right click on Harris Barclay’s 7ENG_2 class   
 

 
 

• Click Change Teacher 

• Select the third option – Replace ALL Occurrences of the Selected Staff member- and 
click OK 

 

 
 

• Click OK 

• Read the message and click Yes 
 

• Highlight Elaine Abbott and click OK 

• Switch View to Timetable View and find  Elaine Abbott’s timetable 
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Ms Fisher’s Year 8 HASS class (8HASS_1) is changing to the library every Monday Period 
3 

• Filter to the Year 8 grid 

• Filter to the Humanities department 

• Type 8HASS_3 into Search and <Tab> 

Note:  If Departmental colours have been applied, using Search will temporarily turn them 
off. 

• Right click on 8HASS_1 

• Click on Change Room 

• Select Replace Room for the Class Meeting and click OK 
 

 
 

• Select View All 
 

 
 

• Select the Library Conference Room and click OK 
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5.4.4 Combining Classes:  

ACTIVITY 

Timetabling > Timetable 

• Filter to Semester 2, the Year 10 grid and the Design and Technology department  

• Type 10JEW_1 in Search and <Tab> 
 

 
 

• Right click on 10Jew_1 on Tuesday session 4 

• Click Add to Combined Class 

• Give combined class a suitable name, for example, Metals 10 
 

 
 

• Click Add Set 
 

 
 

• Click Yes 
 

• Right click on 10MW_1 

• Click Add to Combined Class 

• Click on Add Set and Yes 
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Note:  The C after the teaching set codes indicate that they belong to a combined set. 

• Close Timetable 
 

 
 

5.5   Grid Modelling 

Timetabling > Grid Modelling 

GRIDS are the focus of timetabling activity and can be created or cloned from previous years. All 
staff, rooms and subjects can be made available or unavailable, where required, to a grid.  The grid 
provides the framework within which the teaching sets required to satisfy the selections of students 
within the grid will be placed. 
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Grids are made up of BANDS and are divided up into BAND RECORDS.  The frequency of a band 
(indicated in brackets after the number of the band) indicates the number of band records 

associated with that band.  The band records may be viewed by clicking on the Plus  icon on 
the band. 
 

 
 
Teaching sets placed on a band record meet concurrently.  Band records can be individually 
manipulated.  

Note: If band records are left empty, then some students at least will have blanks in their 
timetables. 

Band records are mapped to the Inter-grid Linkage Table: Timetabling > Grid Modelling > 
Functions > Inter-grid Linkage Table. 
 

 
 
Each slot in the Inter-Grid Linkage Table is linked to a single period in the Timetable Cycle.  This is 
done in Timetabling > Grid Modelling > Functions > Time-Slot Mapping. 
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All teaching sets placed on a band record will meet in the period to which the band record has 
been mapped. 
 

 An (F) (Fixed) after the subject name on the grid indicates that the teaching set 
has been placed on the band manually and can only be moved or removed manually unless its 
status is changed to Unfixed. 
 

 This symbol indicates that the teaching set is locked, that is students can be moved neither into 
nor out of the teaching set through Grid Modelling. 
 

5.5.1 Making Changes to the Grid 

Timetabling > Grid Modelling 

Changes within the school may require changes to the grids that make up the timetable. 
 

• Unlock the grid by clicking on the key  
 
The following will be displayed: 
 

 
 

A copy of the grid as it was on unlocking is saved and may be restored by clicking Retrieve  
Snapshot.   
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Note:  Users may also take snapshots  of the grid at any time it is unlocked. 

Before the bands of a grid which has been Saved as Timetable can be remodelled, the 
schedule(s) to which the bands are linked must be Unsaved.  Bands of grids linked to the 
schedules in the process of being remodelled will be unavailable to the timetable until they are 
resaved. 
 
To Unsave a grid for remodelling: 

• If necessary, unlock the Timetable 

• Select Grid Modelling from the Timetabling sidebar 

• Select the Grid required 

• Unlock the grid 

• Select the Function menu and click on Save as Timetable 
 

 
 

• Highlight the schedule of the grid to be unsaved for remodelling and click on Unsave 
 

 

Note:  You are advised to unsave the entire grid.  This will allow you to restore the system 
snapshot if required.  

• Close the Save as Timetable window 

Note: While a grid schedule has been Unsaved, the bands associated with the schedule will 
not be available to the Timetable or Timetable view of Student Course. 

 
Once the grid is unsaved, the following menu is available through a right click in a cell: 
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Move Teaching Set allows the user to move the teaching set 
to another band or band record. 
Change Selected Students’ Teaching Set allows the user 
to move one or more selected students from one teaching set 
to another on the same band. 
Change Teaching Set allows the user to change the set 
from one subject to another, for example from Art to Craft. 
Remove Teaching Set allows the user to remove the 
teaching set from the grid. 
Mark As Non-Fixed Element allows the user to change the 
status of the set from Fixed – may only be moved manually – 
to Unfixed – may be moved automatically. 
Show Teaching Set Members allows the user to view a list 
of students in the set. 
Lock Teaching Set prevents students being moved or out of 
that teaching set in Grid Modelling. 

 

5.5.2 Add a Teaching Set to the Grid 

• Define subjects through Admin > Parameters > Subjects 

• Make subjects available to the grid (Timetabling > Timetable Set-up > Individual Grid 
Parameters > Subjects) 

• Unsave the grid (Timetabling > Grid Modelling > Functions > Save as Timetable) 

• Add a teaching set for the new subject (Tools > Add A Teaching Set) 

• Click on the scroll in the top tool bar  to display a list of the available teaching sets  
 

 
 

Teaching sets displayed in red have been fully assigned to the grid.  That 
is the number of band records onto which the teaching set has been 
placed is equivalent to the frequency for that subject.  Subject 
frequencies are determined by the number of times classes for that 
subject will meet during one rotation of the timetable cycle.  
 
Teaching sets displayed in blue have been partially assigned to the grid.  
That is the number of band records onto which the teaching set has been 
placed is less than the frequency for the subject. 
 
Teaching sets displayed in black have not been assigned to the grid.   

Note: Teaching sets may not be placed onto more band records than 
the subject frequency, unless the grid bands have been assigned to 
more than one schedule (timetabling period).  

In the example below, 2XECO has a frequency of two.  However, teaching sets for this subject 
may be placed onto four band records because Band 1 has been assigned to Semester 1 and 
Band 2 to Semester 2. 
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• Unlock the Band on which the teaching set is to be placed by clicking on the padlock.   
 

 Locked  Unlocked 
 

• Click and drag the new teaching set on to the desired (unlocked) band  

• Open the Save as Timetable window, select the grid schedule and Save  

• Lock  the grid 
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5.5.3 Split a Class 

ACTIVITY 

This activity will split a Year 10 Food Production class and re-allocate students. 

Timetabling > Grid Modelling 

• Unlock  the 2019 Year 10 grid  
 

 
 
A copy of the current grid is saved and may be retrieved if required. 
 

• Click Functions  

• Select Save As Timetable 

• Highlight grid 2019-10 
 

 

Note: The entire grid must be unsaved otherwise it will not be possible to retrieve a grid 
snapshot. 

• Click Unsave  

• Click Yes, then click Close when the grid is unsaved 
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• Type 10FOOD in Search and <Enter> 
 

 

Note:  If Departmental colours have been applied, using Search will temporarily turn them 
off. 

• From Tools select Add Teaching Set  

• Highlight 10Food, drag and drop into Subject Code field and click Add 
 

 
 

• Click No as you do not wish to add students yet 
 

• Make sure Band 9 is unlocked by clicking on the padlock on the left of the Band   

Note: If all bands are unlocked, click on Lock All Bands in the Tools menu and then unlock 
Band 9 

• Click Display Teaching Sets  

• Drag and drop new set - 10 Food_3 - on Band 9 
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5.5.4 Move Students between Teaching Sets 

ACTIVITY 

Timetabling > Grid Modelling 

• Right click on 10Food_2 and select Change Selected Students’ Teaching Set 
 

 
 

• Select 10Food_2 and the students you wish to move 
 

 
 

• Click OK and Yes 
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5.5.5 Take a Snapshot 

ACTIVITY 

Timetabling > Grid Modelling 

• Click Take a Snapshot  
 

 
 

• Check Full Snapshot and click OK 
 

 
 

• Enter a Code and Description and click OK 
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5.5.6 Change Teaching Set 

ACTIVITY 

Timetabling > Grid Modelling 

This activity will change a teaching set from Art to Craft. 

• From Tools select Add Teaching Set 

• Highlight Craft 10, drag and drop into Subject Code field  
 

 
 

• Click Add  

• Click No as you do not wish to add students yet 
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• Ensure Band 10 is unlocked 

Note: If all bands are unlocked, click on Lock All Bands in the Tools menu and then unlock 
Band 10 

• Right click on 10Art_1 and select Change Teaching Set 
 

 
 

• Click OK and Yes 
 

• Tools > Delete Teaching Set 

• Drag and drop 10Art_1 into Teaching Set Code 

• Click Delete and OK 
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5.5.7 Restore a Snapshot 

ACTIVITY 

Timetabling > Grid Modelling 

• Click Retrieve a Snapshot   
 

 
 

• Select SS1 and click OK  
 

 
  



 
Integris Timetable Construction   

Page 73 of 248 

© 2019 Civica Pty Ltd 
 

 

5.5.8 Save as Timetable 

ACTIVITY 

Timetabling > Grid Modelling 

Functions > Save as Timetable 

 

 
 

• Highlight the Year 10 grid for both semesters and click Save and Yes 

• Close and lock  the grid 

• Click Yes to save the changes 

• Close Grid Modelling 
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5.5.9 Allocate Teachers and Rooms 

ACTIVITY 

Timetabling > Timetable 

• Use the filters to help you locate the new Food class in Semester 1 
 

 
 

• Allocate a suitable teacher by right clicking and selecting Allocate Teacher 

• Select Allocate Staff member to ALL Class Meetings for the Teaching Set 

• Select a staff member from the list and click OK 

• Allocate a suitable room by right clicking and selecting Allocate Room 

• Select Allocate Room to ALL Class Meetings for the Teaching Set 

• Select a room from the list and click OK 

• Close the timetable 
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5.6 Operational and Maintenance Reports 

Timetabling > Reports 

Timetabling reports are located within the Report sidebar option. 
 

        
 
Operational and Maintenance reports are of greatest use once the timetable is operational.  There 
are Operational and Maintenance reports on: 

• the Timetable 

• Students 

• Staff 

• Rooms  

• Teaching Sets 
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ACTIVITY 

View the following reports. 

Timetabling > Reports > O&M Reports – Students > Student Timetable by Date Range 

• Find Ben Anderson and Rachael Andrews 

• Check Include Tutor(s) Names and Contact Details  

• Print the report to the screen 
 

  
 

Timetabling > Reports > O&M Reports – Students > Clearance Form 

• Select the current term 

• Click New Query to find Rachael Andrews  

• Check Show Contact 
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• Click Edit Text  

• Edit some other text to reflect the practice in your school  
 

 
 

• Click OK 

• Print the report to the screen 
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Timetabling > Reports > O&M Reports – Students > Course Change Report 

• Find Year Group 10 
 

 
 

• Print the report to the screen 
 

 
 

• Click OK twice 
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Timetabling > Reports > O&M Reports – Students > Re-admission Form 

• Leave the date range as TODAY 

• Click Find, OK and Yes 
 

 
 

• Print the report to the screen 

Note: This report will only be available in the reports menu if students have been moved 
to the former roll during the selected Timetable Year and Leave Date range using 
 

.  
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Timetabling Reports > O&M Reports – Staff > Staff Load 

• Click Find by Department 

• Select Mathematics 
 

 

Note the options to select A3 Paper and Select Periods. 

• Print the report to the screen 

• Select Transpose report  

• Print to the screen again 
 

• Uncheck Transpose report  

• Select  

• Click Print 

• Save to the Desktop 
 

 
 

• Click OK 

• Minimize Integris and double click on Staff_Load.csv on the desktop 

• View, then close 

• Maximize Integris 
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Timetabling > Reports > O&M Reports – Staff > Free Teacher Summary 

• Print to the screen the Free Teacher Summary for All periods TODAY  
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Timetabling > Reports > O&M Reports –Rooms > Room Load 

• Click Find by Department 

• Select Science 
 

 

Note the options to select A3 Paper and Select Periods. 

• Print the report to the screen 

• Select Transpose report  

• Print to the screen again 
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Timetabling > Reports > O&M Reports –Rooms > Free Room Summary 

• Print to the screen the Free Room Summary for All periods TODAY  
 

 
 

Timetabling > Reports > O&M Reports –Teaching Sets > User Defined Teaching Set Lists 

• Click each of the radio buttons: Teacher, Department, Subject/Teach Set 

• Select Teacher and Elaine Abbott 
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• Click the Includes tab 

• Check Student Form, Parent/Guardian Name, Parent/Guardian Phone 

• Enter 6 in Number of Columns 
 

 
 

• Print the report to the screen 
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5.7 Review: 

ACTIVITY 

Note the pathway you took to complete each of the following tasks 

1. Steven Bailey (Year 10) has decided he wants to do Indonesian instead of Italian.  (Hint: This 
is a two-way swap, and do not forget the billing implications.) 

 
 
 
 
 
2. Christabel Norton is taking over 9PE_2 from Minnie Mouse.  Make the necessary changes in 

the timetable. 
 
 
 
 
 
3. In Semester 2, combine Teaching Sets 9Art_1 and 9Craft_1. 
 
 
 
 
 
4. Move Mr Evans class 9HASS_2 to the library on Mondays only.  (Hint: the library is not a 

preferred room for Humanities and Social Science.) 
 
 
 
 
 
5. In Semester 2, split the teaching set 9MW_1.  
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6 Timetable Construction 

The Timetabling module will allow users to create and maintain timetables for students, staff and 
rooms for multiple campuses and period structures as required.  It is a logical tool for staff to 
explore the best possible timetable given the resources of the school.  
 

6.1 Preparing a Timetable Model 

Prior to beginning creation of a new timetable, it is a good idea to prepare a timetable model.  The 
timetable model will help the user later in creating the best possible timetable for the school.  
Points that should be considered are: 
 

• Timetable Periods – will the school operate over semesters, terms or other user-defined 
periods? 

• Length of Cycles – how many days will form one cycle of the timetable and is more than one 
cycle needed? 

• The Timetable Day – how many periods will be timetabled per day and the lengths of these 
periods? What breaks will be included within the day? 

• Campuses – will the school operate more than one physical or logical campus? 

• Staff – what staff will be available to the timetable and what will be their teaching loads? 

• Rooms – what rooms will be available to the timetable? 

• Grids – what grids will be used and for what period will these grids operate? 

• Schedules – what schedules will apply to each grid? 

• Subjects – what subjects will the school offer within each grid? 

• Preferences – the number of subjects that must be selected by students within each grid, which 
of these are required and which are electives?  What pathways need to be considered and are 
there prerequisites or selection patterns? 
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6.2 Constructing the Timetable 

Construction of the timetable may be broken down into the following stages of development.   

Please note that not all of these steps are necessary, as different schools will have different 
timetabling needs.  Mandatory steps are indicated with an asterisk. * 

General > School Details 

1. Set up Timetabling Year * 
2. Define Timetable Periods * 
3. Setting Parameters 

• Campuses  

General > Parameters 

• Faculties  

• Departments * 

• Room Types and Rooms * 

• Subject Areas, Classification and Type, and Subjects * 

Timetabling > Set Up 

• Campuses  

• Define Cohorts * 

• Staff Preferred Subjects 

• Subject Preferred Rooms 

• Course Promotion Table 

• Period Types  
 
4. Define Cycle 

• Add a Cycle * 

• Master Period Structure * 

• Staff Availability * 

• Room Availability * 
 
5. Define Grids 

• Grid Cohort of Students * 

• Grid Period Structure  

• Grid Subjects * 

• Grid Subject Groups  

• Grid Rooms  

• Grid Staff  
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Timetabling > Preferences 

6. Student Preferences * 

• Individual Entry 

• Bulk Entry 

• Promote Student Courses 
 
7. Subject Load Table * 

• Edit 
 
8. Manual Teaching Set Allocation 

Timetabling > Grid Modelling 

9. Grid Modelling * 

• Manual Set Allocation to Grid 

• Enter Constraints 

• Inter-grid Constraints 

• Auto-schedule Process 
 
10. Refining Student Placement * 

• Fit unplaced students  

• Balance sets  
 
11. Map time slots to teaching periods (Functions>Timeslot Mapping) * 
 
12. Save grid to the timetable (Functions>Save As Timetable) * 

Timetabling > Timetable 

13. Allocate Staff and Rooms * 

• Manual allocation 

• Auto allocation  
 
14. Lock Timetable 
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6.3 Timetable Year 

General > School Details > School Diary 

The timetable year must be defined before attempting to create a new timetable.  This may be 
done at any time and for any number of years and does not affect the current school year.  A 
default timetabling year will be created to match the school year.  The start and end dates for the 
timetabling year may differ from the school year but must match the Lesson Attendance year 
exactly. 
 
It is suggested to enter future timetable years based on the tentative dates released by the 
Department on a yearly basis. 

Note:  Creating a new school year automatically creates a default timetable year. 

ACTIVITY 

Set up a new school year for next year. 

General > School Details 

Note:  You should always back up your data file prior to setting up a new year. 

• Click Display School Diary  

• Click Set Up School Year  

• Click Display Diary for Specified Year to double check that the following year has not 
already been set up 

• Select Set up year structure and click OK 
 

 
 
The School Year window will be displayed, showing this year’s terms. 
 

• Enter the 2020 in the School Year field and <Tab>  
 

• Click Yes when asked if you want to discard last year’s data 
 

• Change  to  
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Set up terms for the new year:  

• Click Add Term  to add details of terms, one at a time, dates may be typed in or 
selected via the Activity Calendar button 

 

 
 

• Add the other terms  
 

 
 

• Click OK  
 

Note:  It is strongly recommended that Terms are always entered as starting on a Monday.  
If the school is not open on the Monday, it may be entered as a Close day in the School 
Diary. 

 

These dates are preliminary only. Please check the DoE’s website before creating the 2020 
school year. 
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Identify days in the school year that when school will be closed: 

• Click on Toggle Paintbrush   

• Click in the green School Development cell 

• Click on Monday 3 and Tuesday 4 to indicate school development days 
 

 
 

• Click Next Month  to move to March 

• Click in the blue Holiday cell 

• Click on Monday March 2 to indicate a public holiday 

• Repeat for 27 April and 1 June 

• Close the school diary 
 

 

Note: Someone in your school will need to take responsibility for entering all public 
holidays, school development days and other school activities in School Diary.  Close dates 
are essential for Lesson Attendance but do not affect Timetabling. 
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6.4 Timetable Periods 

General > School Details > Timetabling Periods 

Timetable periods define the start and end dates for the operation of a grid or schedule within the 
timetabling year.  For example, a grid or schedule may operate for a term, semester, year or any 
user definable period. 
 
A default timetabling period will be created automatically which spans the whole timetabling year.  
If the school operates on terms or semesters and these dates have been entered in the school 
year, default timetabling periods based on the entered dates will be created.  The user may accept 
these defaults or create other timetable periods such as learning blocks.  The user must enter the 
start and finish dates of the timetable periods.  Dates must be entered prior to creating a new 
timetable.  
 

ACTIVITY 

Define Semesters 1 and 2  

General > School Details 

• Click on Timetabling periods  

• Ensure 2020 is selected 

• Click on  to create semester periods 
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Add Upper School Semesters 

• Click Add  and enter Code, Description and Dates  

Note: Use the double arrows in the date selector to take you forward to 2020. 

 
 

• Click OK  

• Add Upper School Semester 2 
 

 
 

• Close the Timetabling Periods window  
 

 
 

6.5 Campuses 

General > School Details > Sites 

Campuses are defined as either physically separate locations of school buildings or logical groups 
within the school that may employ the same or different timetabling cycles.  Physically separate 
campuses may be stored within school details and accessed through the timetable module.  
Campuses, either physical or logical, may change from year to year so the campuses are linked to 
a timetable year and attached to a cycle.  The campuses once created may be flagged as inactive 
and therefore not available to users or deleted.  However, a campus cannot be deleted if it has 
been linked to a grid. 

Note: Timetable cycles will be linked to the campus and resources may not be manually 
shared amongst campuses unless they are using the same cycle and period structure. 

A physical campus should first be defined within school details on the general sidebar before 
making it accessible to the timetable.  Logical campuses should only be created within the 
Timetabling module as these campuses are only for use within the timetable.  Campuses may be 
added, edited, deleted, made active or inactive and locked. 
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ACTIVITY 

Create a physical campus and make it accessible to the timetable. 

General > School Details 

• Click Sites  and Edit  

• Click Add  and enter Middle School in the Address field  
 

 
 

• Click OK  

• Repeat for the Senior School 

• Click OK twice and close the School Details window 
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6.6 Timetable Setup 

Timetabling > Timetable Setup 

Parameters created in Timetable Set Up may apply to more than one timetabling year.  These 
parameters need to be entered once and are then modified as required prior to creating a new 
timetable.  These functions may be modified during the year if necessary. 
 
The following screen shows the Timetable Set-up menu: 
 

 
 
 

ACTIVITY  

Timetabling > Timetable Set-up > Campuses  

• Click Create Campuses from School Sites   

• Click Yes and OK 
 
Any sites that have been entered in the School Details will now be available. 
 

• Highlight C2 to C6 and delete them  

• Click Yes  

• Click OK 
 

 
 

• Close 
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6.6.1 Cohorts 

Timetabling > Timetable Set-up > Cohorts 

A cohort is a group of students who will be timetabled within a grid.  Usually a cohort will consist of 
a year level or class, for example all year eight students may be included in a cohort.  However, 
the students who may be included in a cohort is only limited by the constraints of the school.  
Cohorts may be associated with more than one timetabling period, for example, the same Year 9 
cohort may be associated with Semester 1 and Semester 2. 
 
Students will be selected for a cohort using the Student Find or by cloning a cohort from a previous 
timetabling period and renaming it.   
 
Students may be added to the cohort as required.  They may also be removed from the cohort if 
necessary.  However, if the student has subject preferences or teaching sets attached the user will 
be warned of this when removing the student.  If a student is removed from a cohort, the class 
totals will reflect this change and the student will be removed from any associated teaching sets. 
 
Students listed on the admissions roll may be added to cohorts at any time.  However, as a student 
is moved from admissions to the current roll, the user will not be prompted to add the student to a 
cohort even if he or she is not already in a cohort.  

Note: Users entering students after the timetable has been created will be prompted to 
select a cohort at time of enrolment.  Users moving students to the former roll will be 
prompted to remove the student from the cohort.  However, the user will also have the 
option to have the leaving student remain in a current cohort and teaching sets.  These 
students will be highlighted in red on class rolls to distinguish them from current students. 

 

Note: Before creating cohorts, consider the grids that you will be using.  For example, many 
schools have an Upper or Senior School grid that includes both Years 11 and 12. 

  



 
Integris Timetable Construction   

Page 97 of 248 

© 2019 Civica Pty Ltd 
 

 

ACTIVITY 

Create a cohort including all Upper School students. 

Timetabling > Timetable Set-up > Cohorts 

• Select the 2020 school year 

• Click on the green tick  to make 2020 the default year for Timetable Setup 

• Adjacent to Cohort Name click Add  

• Enter the name - US - and click OK 

• Highlight the cohort  

• On the right-hand side click Add  

• Find Years 10 and 11 
 

Create a Year 7 cohort. 

• Adjacent to Cohort Name click Add  

• Enter the name - 07 - and click OK 

• Create a Year 7 cohort from the Year 6s on the Current roll and Year 7s on the Admissions 
roll 
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Clone a Year 8 cohort from 2019 Year 7. 

• Add Cohort   

• Type 08 and check Clone 

• From the drop-down menu, select 2019– 07  
 

 
 

• Click OK 
 

• Clone a Year 9 cohort from 2019 Year 8 

• Clone a Year 10 cohort from 2019 Year 9 
 

Check that all students are attached to a cohort. 

• Click on Refresh  

• Click on Year/Form to order students 

• Look for students in Years 7 to 11 who are not in cohorts 

• Select Y09 from Cohort Name 
 

 
 

• Double click on Oliver Brown 

• Click Close 
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6.6.2 Staff Preferred Subjects 

Timetabling > Timetable Set-up > Staff Preferred Subjects 

The Timetabling module is able to manage and monitor the allocation of staff to the timetable.  This 
will only be possible if the subjects that a staff member is able to or designated to teach are 
recorded.  This is an optional process.   
 
Staff preferred subjects might be based on qualifications, experience and/or preference.  This 
information may vary from year to year but can be cloned from a previous year and then modified.  
The preferred subject(s) may be prioritised using a ranking system between 1 and 10.  A staff 
member may also nominate a room as the preferred room.  If resource monitoring is enabled, the 
auto-scheduling process will take into account the preferred subject(s) for staff as an additional 
factor when determining the placement of subjects on the grid.  
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ACTIVITY 

Clone subjects for all staff from a previous year. 

Timetabling > Timetable Setup > Staff Preferred Subjects 

• Ensure 2020 is selected  

• Click on Clone Between Years  

• Clone from 2019 
 

 
 

• Click OK and Yes 
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Add Years 7 to 10 English as preferred subjects for Elizabeth Taylor.  

• Find  Elizabeth Taylor  

• Click Edit  

• Check  

• Click on the Subject Name column header to organise subjects alphabetically 

• Highlight Years 7, 8, 9 and 10 English and click on the blue chevron (arrow) 
 

 
 
The subjects will appear in the right-hand window.   
 

• In the same way add Media 9 

• Highlight Media 9 and in the bottom right hand corner type 2  

• <Enter> 
 
Media 9 has a ranking of 2. 
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Add MS6 as the preferred room for Elizabeth Taylor. 

• Click Edit Preferred Room   
 

 
 

• Enter the Room Code MS6  

• Click Find 
 

 
 

• Highlight MS6 

• Click Select and OK 
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Add Humanities and Social Sciences Years 7 to 10 to Lyle Wagner and Marcus Williams. 

• Click Bulk Allocation  

• Find  Wagner and Williams  
 

 
 

• Click Subject Find  on the right 

• Find by Department: Humanities 

• Check Find Active Subjects only 
 

 
 

• Highlight HASS 7 to 10 

• Click Select 

• Click Add Subjects and Yes 
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Add Elizabeth Taylor’s subjects to Wagner and Williams 

• Click on Get Subjects from Staff Member  and Yes 

• Find Elizabeth Taylor 

• Highlight all of the English subjects and enter a rank of 2 in the bottom right-hand corner of 
the window 

• Click  

• Click Add Subjects and Yes  

• Close  
 

• Find Marcus Williams and view his preferred subjects 

• Close  
 

 

6.6.3 Subject Preferred Rooms 

Timetabling > Timetable Set-up > Subject Preferred Rooms 

The user may wish to define one or more preferred rooms for a subject.  If preferred rooms are 
assigned to a subject, the room allocation process will offer these rooms for manual allocation, 
automatically assigning those flagged as ‘must have’ first.  Only one room for each subject may be 
flagged as ‘Must have’.  Rooms that are allocated ‘Must not have’ will not be allocated to the linked 
subject.  Preferred rooms may be cloned and/or edited for use in future timetables. 
 
Preferred rooms may be ranked as  
1. Must Have 
2. Highly Desirable 
3. Desirable 
4. Take if Necessary 
5. Must Not Have 
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ACTIVITY 

Clone subject preferred rooms from a previous year. 

Timetabling > Timetable Set-up > Subject Preferred Rooms 

• Select 2020 

• Click on Clone Between Years  

• Select 2019 
 

 
 

• OK and Yes 

Allocate D1 and 2 as Highly Desirable for all Drama subjects. 

• Click Bulk Allocation  

• Find  the Active Drama subjects 
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• Find  the Performing Arts rooms  
 

 
 

• Highlight both the Drama rooms 

• Change the rank of both to Highly Desirable  

• Click on the green tick  

• Click Add Rooms and Yes 

• Close 
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6.6.4 Promoting Student Courses 

Timetabling > Timetable Set-up > Maintain Course Promotion Table 

Promotion of a student’s course is a tool designed to make entry of subject preferences easier.  
Students who studied a pre-requisite subject in one timetabling period may want to list the 
subsequent subject as a preference for the next timetabling period.  By using the promote student 
course function entry of the preference is automatically updated for selected students. 
 
If you want to promote a student’s courses from one timetabling period to another, the promotion 
path for the subject must be defined showing how students will be moved from a subject in one 
timetabling period to a subject in a subsequent period.  The Course Promotion Table performs 
this function and will need to be set up prior to the course promotion function being run.  The 
Course Promotion Table will apply to all timetabling years and grids so need only be set up once 
and then edited as required.  
 
The table will be used to take all students studying a subject in one timetabling year. For example, 
Year 8 English to be promoted based on user choice, to a different subject, for example Year 9 
English, in the next timetabling year.  Not all subjects within a student’s course need be promoted.  
When applying the course promotion table, the timetabler is able to selectively enable or disable 
the promotion of each subject or, if appropriate, individual students within each subject. 
 

Editing the Course Promotion Table 

The Course Promotion Table is accessed from the Timetabling > Timetable Set-up > Maintain 
Course Promotion Table. 

Note: Only those subjects used for promotion need be defined.  The Promote Student 
Course function is only available and initiated from the Bulk Student Preference window. 
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ACTIVITY 

Enable the promotion of students of Year 8 English, Home Room, Maths, Phys Ed, 
Science, and Society and Environment to the same subjects in Year 9. 

Timetabling > Timetable Setup > Maintain Course Promotion Table 

• Click Edit  

• Click Show available subjects    

• Drag the Available Subjects window to the right of the Course Promotion Table 

• Check Only show active subjects 

• Drag and drop English 8 into the From column  

• Drag and drop English 9 into the To column 

• Repeat for the other subjects 
 

 
 

• Click OK and Yes 

• Close 
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6.6.5 Period Types 

Timetabling > Timetable Set-up > Period Types 

Period types are used to define teaching and non-teaching periods.  A default set is provided and 
includes: 
 
T – Teaching Period  
H – Home 
L – Lunch 
B – Break 
 
The user must NOT edit or delete the T or H codes as the auto scheduling process only works on 
teaching periods, for which a standard code must be available.  Lesson Attendance also requires T 
and H as fixed codes.  However, the labels for T and H may be renamed if it is required. 
 
Before editing, deleting or changing the status of a period type, the codes must be unlocked.  
Additional period types may be added or edited and the other defaults may be edited as required 
as these are only used for reporting purposes and shown on timetable printouts.  However, a 
period type may not be deleted if it has been used in a period structure.  Apart from T and H period 
types may be flagged as inactive and consequently will not appear on selection lists. 
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ACTIVITY 

Unlock and rename Home and Break and lock them again. 

Timetabling > Timetable Set-up > Period Types 

• Highlight Home and Break 

• Click Unlock  

• Click Yes 

• Click Modify/Add  

• Rename Home and Break with the terms used in your school (but do not change the code)  

• Click OK 

• Lock  both parameters 
 

 
 

6.6.6 Subject Relationship Table 

The Subject Relationship Table allows users to link single or multiple subjects between years and 
to make recommendations about students’ future subjects. 
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ACTIVITY 

Timetabling > Timetable Set-up > Subject Relationship Table 

• Click Add Year Subject  (in the centre) 

• Find AELIT 
 

 
 

• Click Select  
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• Highlight AELIT in the pane on the left and click Add Related Subjects  on the right 

• Find the ATLIT and GTLIT 
 

 
 

• Click Select  
 

 
 

• Click OK 
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Timetabling > Timetable Set-up > Subject Relationship Table 

• Click on the Subjects Without a Relationship tab 

• Select the Year 10 grid for the current year 

• Click Add Faculty  (in the centre) 

• Highlight Humanities and Social Science and click OK 

• Highlight Humanities and Social Science in the pane on the left and click Add  Faculty 
Related Subjects on the right 

• Click on the Subject Name column header  

• Select GECAE and click OK 
 

 
 

• Click OK again 
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6.6.7 Data Entry 

The Data Entry window allows users to make future Subject recommendations for existing 
students. 
 

ACTIVITY 

Timetabling > Data Entry 

• Find  Carl Best 

• Select the Upper School grid and AELIT_1 

• Select multiple cells by clicking in each one 

• Right click in one of the selected cells and choose a recommendation 
 

 
 

• Repeat with different recommendations for some other students 

• Click OK twice 

• Click Cancel to close the window 
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6.6.8 Subject Recommendation and Selection Sheet 

ACTIVITY 

Timetabling > Reports > Data Validation Reports > Subject Recommendation and 
Selection Sheet 

• Select this year’s upper school grid  

• Enter an Instruction to Parents 

• Check Print each Student on a fresh sheet 

• Find the students in Form 11.1 
 

 
 

• Print to the screen 
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6.7 Timetable Cycles 

Timetabling > Timetable Set-up > Timetable Cycles 

At least one timetable cycle must be defined for each timetabling year. This must contain the 
details of the cycle dates and period structures the school will use.  The timetable cycle draws 
details from the school calendar and forms the connection to the Lesson Attendance Year.  
 

• Cycles may remain in use for a number of years or may change from year to year.  

• A cycle will be linked to the timetabling year via the grids that use it and may be cloned and/or 
edited for use in future years.  

• The number of days within a cycle is unlimited. If a five-day cycle is chosen, the day names will 
default to Monday, Tuesday etc.  If any other cycle is chosen, the day names will default to Day 
1, Day 2 etc.  The day names are editable if required. 

• Cycle details may be added progressively over time.  

• A row refers to a line on the timetable and this may be a teaching period or a break, for 
example lunch.  Therefore, five rows per day may indicate five teaching periods or any 
combination of teaching periods and breaks for example, three teaching periods, recess, and 
lunch. 
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ACTIVITY 

Create the 2020Cycle for the school (Years 7 to 12) with a five-day cycle. 

Timetabling > Timetable Setup > Timetable Cycles 

• Ensure the 2020 school year is selected 

• If necessary, click on the green tick to make 2020 

•  the default 

• Click Add  

• Enter the following information  
 

 

Note: Thursday is an early finish day 

• Click OK and Yes 
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6.7.1 Master Period Structure 

Timetabling > Timetable Setup > Timetable Cycles > Master Period Structure 

The maximum number of periods and the timing of the periods required by any cohort using the 
cycle must be defined.  Where cohorts use variations on the default structure, grid definition will 
allow masking of unused periods for a particular cohort. 

Note: The master period structure can be edited at the time of cycle creation or at a later 
point if required. 

If you would like to show breaks for example, lunch, recess and/or sporting activities, these must 
be included when calculating the number of rows per day and then include these breaks and/or 

activities when inserting the timing of periods.  Rows may be added to the Master Period 
Structure following the creation of the timetable to accommodate breaks, form or other 
changes using the Add Above or Add Below buttons. 
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ACTIVITY 

Create a master period structure 

Timetabling > Timetable Set-up > Timetable Cycles  

• Ensure 2020 is selected 

• Click on the Master Period Structure tab 

• Click Edit  to the right of the Master Period Structure pane 

• Enter Monday’s period times.   

Note: The correct codes for Period Type and AM and PM are essential for Lesson 
Attendance. 
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• Click Copy Periods  

• Highlight rows 1 to 8 and Tuesday to Friday 
 

 
 

• Click OK  
 

• Edit the period times and codes for Thursday 
 

 
 

• Click OK  
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Edit the row labels  

• Click Edit  on the right  

• Edit the row labels as shown 
 

 
 

• Click OK 

• Click Display Preview   
 
Your cycle should appear like this. 
 

  
 

• Close Preview  
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6.7.2 Staff Availability 

Timetabling > Timetable Set-up > Timetable Cycles > Staff Availability 

Staff must be made available to the cycle to be allocated classes within the grids.  The Full Time 
Equivalency (FTE) of the staff must be added, edited or cloned in this window.  The FTE is drawn 
from the Default FTE in School Details that should be marked as 1.00.  Non-teaching activities, for 
example, DOTT may be defined for staff and are used to calculate Net FTE that is used by the 
auto-scheduling process.  The Net FTE is important as the auto-scheduling process takes this into 
account when allocating classes to staff.  Net FTE for timetabling purposes is defined as the 
contact time for each teacher that has a Net FTE of 1.00 means that the teacher is available to 
teach all teaching periods.  

Note: If any staff member has an FTE of 0.00, the auto-schedule process will not be able to 
allocate that staff member to any class. 
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ACTIVITY 

Allocate all staff except for Marie Theresa Alan, Sandra Corner and Tony Duke to 2020 

Timetabling > Timetable Setup > Timetable Cycles > Staff Availability 

• To clone staff’s FTE from a previous year, click Clone  

Note: It is highly recommended that, whenever possible, staff availability is cloned from 
one cycle to the next so that the Net FTE does not need to be entered again. 

• Select 2019 and click OK 
 

 
 
All staff available to the chosen cycle will be cloned for the current cycle. 

• Highlight the three teachers who are leaving and click Delete  and Yes 
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Harris Barclay will only be working part-time next year. 

• Click on edit FTE  and give Harris Barclay an FTE of 0.80  
 

 
 

• Click OK 
 

• Highlight Harris Barclay and click on Non-teaching Activities  

• Click on Edit  and reduce his DOTT to 0.16 
 

 
 

• Click OK, Yes and Close 
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Allocate non-teaching activities of 0.20 FTE for Head of Learning Area duties to Luke 
Evans  

• Highlight Luke Evans 

• Click on Non-teaching Activities  

• Click Edit  

• Enter the appropriate information including the FTE 
 

 
 

• Click OK, Yes and Close 
 

 

Note: Non-teaching activities may also be entered through Timetabling > Timetable Set-up > 
Individual Grid Parameters > Staff. 
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ACTIVITY 

Timetabling > Timetable Setup >Timetable Cycles > Staff Availability 

Elizabeth Taylor will be a new teacher in the school next year. 

• Click Add  

• Enter TAY in the Name/Number field and click Find 
 

 
 

Edit Elizabeth Taylor’s net FTE 

• Click Non-teaching Activities  

• Click Edit  

• Enter a Code, Description and FTE 
 

 
 

• Click OK and Close 
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6.7.3 Room Availability 

Timetabling > Timetable Setup > Timetable Cycles > Room Availability 

A set of rooms must be made available to the cycle.  They may be shared between campuses 
using the same cycle.  Rooms must first be entered within the Administration Manager to be able 
to be allocated to a cycle.  Rooms may be cloned from one cycle to another.  Rooms cannot be 
shared between cycles in the same timetabling year. 

Note: The usual practice in schools will be to make all staff and all rooms available to the 
cycle. 
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ACTIVITY 

Allocate rooms to the 2020-5 cycle. 

Timetabling > Timetable Setup > Timetable Cycles 

• Select the Room Availability tab 

• Click Clone Rooms  

• Select 2019 
 

 
 

• Click OK 
 

Make the new rooms available to the timetable: 

• Click Add  

• Find by Room Type: Performing Arts 
 

 
 

• Click Select and Yes 

• Close Timetable Cycles and Timetable Set Up 
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6.8 Review 

ACTIVITY 

Note the pathway you took to complete each of the following tasks 

1. Add term long timetabling periods for 2020. 
 
 
 
 
 
 
2. Change the frequency of Year 10 Art to two.   
 
 
 
 
 
 
3. Add the Year 9 students on the Admissions Roll to the Year 9 cohort for 2020. 
 
 
 
 
 
 
4.  Minnie Mouse, Christabel Norton and Penelope O’Reilly are all qualified to teach GTOED.  

Bulk add this to their preferred subjects. 
 
 
 
 
 
 
5.  Make Drama 1 the preferred room for Jill Lorner.  
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6. Make the Metalwork rooms “Highly Desirable” for 10 Jewellery. 
 
 
 
 
 
 
7. Anna Greaves will be a Year Co-ordinator next year.  Allocate her an additional 0.2 DOTT. 
 
 
 
 
 
 
8. Room SS10 is to be refurbished next year.  Make it unavailable to the 2020 cycle. 
 
 
 
 
 
 

 

6.9 Defining Grids 

Timetabling > Timetable Setup > Timetable Grids 

Grids are the frameworks for development of the whole-school timetable for a timetabling year, 
ensuring the best use of available resources.  Grids may be created or cloned from a previous year 
and renamed, and linked to a campus, a cycle, staff, rooms and subjects.  The grid is linked to a 
timetable period that identifies the length of time the grid remains active.  Grids may be linked to 
one or more schedules, for example, the Year 12 grid may be linked to the Semester 1 and 2 
schedules. 
 

  
 

Note the option to display teachers and rooms on the grid. 
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6.9.1 Adding or Cloning a Grid 

Timetabling > Timetable Setup > Timetable Grids 

Grids may be created or cloned from previously defined grids. 

Adding a Grid 

• Click Add  
 

 
 

• Enter the Name of Grid, Grid Code and Number of Bands 
 
The number of bands will usually reflect the number of subjects students study during the 
timetabling period linked to the grid.  This is a starting value only and may be changed later, 
provided teaching sets have not yet been placed on the grid concerned.  The frequency for the 
bands should relate to the number of times students will attend the classes placed on that band 
during a cycle, for example, four times per week   

Note: These values may also be edited later, provided teaching sets have not yet been 
placed on the grid concerned. 

• Select the appropriate Cycle, Campus, Cohort and Timetabling Period using the drop-down 
boxes 

It is strongly recommended that a timetable period of the school year is 
always selected, at least initially, to allow for maximum flexibility 

• Indicate whether this grid is linked to Upper school by checking the Upper School tick box 
 

 
 

• To have the ability to leave Teaching Sets on the Grid in the positions in which they are placed 
in Grid Modelling tick the box next to the field Editable Grid Display 

 

 
 

• Click OK and Yes 
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Cloning a Grid 

• Click Add  

• Click Clone Grid and select an appropriate grid 
 

 
 

• Change the name, cycle etc. for the new grid 

• Click OK 

• Click Yes 
 

6.9.2 Editing a Grid 

Timetabling > Timetable Set-up > Timetable Grids 

Note: Grids may be edited in this view only before teaching sets have been placed on the 
grid concerned.  After this, grids may still be edited in Grid Modelling. 

• Highlight the appropriate grid 

• Click Edit  
 

 
 

• Amend fields as required 

• Click Close 
 

Adding a Band 
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• Click Edit  
 

 
 

• Change the number of bands to the new value 

• Highlight the new band in the pane on the right 

• Enter the appropriate frequency by clicking on the grey arrows to the right  

• Click Close 
 

Deleting a Band 

• Highlight a band  

• Click Delete   

• Confirm your selection 
 

Increasing/Decreasing a Frequency of a Band 

• Highlight a band. 

• Click on  to increase the frequency 

• Click on  to decrease the frequency 

Note: Band frequencies can only be edited within this screen prior to the placement of 
teaching sets on the grid.  Following this, changes can only be made within the Grid 
Modelling screen.  It is suggested that where possible, the band frequencies be defined at 
this point. 
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6.9.3 Deleting a Grid 

Timetabling > Timetable Setup > Timetable Grids 

• Highlight the appropriate grid 

• Click Delete   

• If the highlighted grid has been saved to the timetable you will be required to enter a password 
 

 
 

• Enter the Password and click OK 
 

 
 

• If you click Yes, another warning message will appear: 
 

 
 

• Click Yes to delete the grid 

• Click No to cancel the selection 
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Note: If the Grid has been saved to the timetable, only those users with an administrator 
status may delete the grid.  The user will be asked to confirm their password before 
continuing with the above process. 

Deleting a grid will remove all grid elements including subjects allocated to the grid and 
student preferences, as well as the placement of these in grid modelling. 

 

6.9.4 Remove Non-fixed Teaching sets 

This feature allows any non-fixed teaching sets to be removed from a grid. They will not be deleted 
and will retain their students. 
 

• Highlight the appropriate grid 

• Click on Remove Non-fixed Teaching Sets  

• If the highlighted grid has been saved to the timetable you will be required to enter a password 
 

 
 

• Enter the Password and click OK 

• The following message will display 
 

 
 

• Click Yes to remove Non-fixed Teaching Sets from the Grid 

• Click No to cancel the selection 

Note: If the grid selected had been saved to a timetable, only those teaching sets that were 
fixed on the grid would still maintain staffing and room allocations on the timetable. 
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6.9.5 Displaying Teachers and Rooms on Grids 

   
 
Checking Show Teachers and Rooms in the Timetable Grids window enable to display of teachers 
and rooms in grids.  This will apply to all grids for all years. 

Note: Once this option is selected, it may take more time for grids to load. 
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ACTIVITY 

Define the grid for Year 8. 

Timetabling > Timetable Setup > Timetable Grids 

• Make sure 2020 is selected 

• Click Add  

• Enter the following information 
 

  

Note: The Edit Timetable Grid screen rather than the Add Timetable Grid screen is 
displayed above only because it is easier to read. 

• Click OK and Yes 
 

It is strongly recommended that all grids are, at least initially, assigned 
to the whole school year.  Grids may be reallocated to a shorter 

timetabling period but never a longer one. 
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Define a grid for Year 9. 

 

Note: The Edit Timetable Grid screen rather than the Add Timetable Grid screen is 
displayed above only because it is easier to read. 

• Click OK and Yes 
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Cloning a grid 

• Click Add  

• Click Clone Grid  

• Select 2019 10   
 

 
 

• Click OK 

• Amend for 2020 10 
 

 

Note: The Edit Timetable Grid screen rather than the Add Timetable Grid screen is 
displayed above only because it is easier to read. 

• Click OK and Yes 
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6.10 Individual Grid Parameters 

Timetabling > Timetable Setup > Individual Grid Parameters 

Once the user has created or cloned a grid, parameters for each individual grid can be viewed and 
refined further.  If the parameters have not been previously selected in the grid definition screen, 
the panes will appear blank. 
 

6.10.1 Grid Cohort of Students 

Timetabling > Timetable Set-up > Individual Grid Parameters > Cohort 

A list of member students in the cohort will be displayed.  A cohort may be linked to several grids in 
one year.  However, only one grid may be attached to one cohort. 
 

 
 

Note: If students have not been added to the cohort, this pane will be blank.  Students 
cannot be added or removed from the cohort within this screen.  This function is performed 
within Timetable Setup > Cohorts.  
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6.10.2 Grid Period Structure 

Timetabling > Timetable Setup > Individual Grid Parameters > Period Structure 

The master period structure defined within the cycle associated with the grid will be made available 
to the grid and is displayed here.  Grid period times and labels for individual grids may be edited in 
this window. 
 

 
 
Only teaching periods (T) will be populated by the auto-scheduling process but other non-teaching 
periods will be displayed on the finished timetable. 
 

6.10.3 Grid Subjects 

Timetabling > Timetable Setup > Individual Grid Parameters > Subjects 

A list of subjects should be made available to the grid so that student subject preferences are 
validated upon data entry. 
 
The subject tab will allow a list of subjects to be selected using a Subject Find tool and linked to the 
grid.  For subjects to be available they must have been previously defined in the Administration 
module (General > Parameters > Subjects).  The subjects may be selected for the grid at any time 
prior to the entry of subject preferences.  Subjects may be cloned or edited for use with future 
grids.  Subjects may be deleted from the grid subject list if no preferences have been recorded for 
that particular subject. 
 
Subjects made available to the grid will inherit default information from the subject parameter table 
or grid from which they are cloned.  This information will need to be verified and modified where 
there are differences applicable to an individual grid.  
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Aspects of subject information that should be checked are: 
 

• Subject Frequency - indicates the number of times a teaching set will meet during a cycle 

• Minimum and maximum class sizes 

• Gender mix 

• Required Subject - means any student with this subject listed as a preference must be 
allocated the subject    
 

To Edit Subject Parameters 

• Select the subject or subjects to be edited and click  
 

     
 

• Make the desired changes and click OK 

Note: If any of the above defaults are edited, they will only affect the selected grid.  If the 
changes are to be global the information should be edited in General >Parameters > 
Subjects. 
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Grid subjects will be made available to bands that have a frequency that matches the subject 
frequency.  The available bands for the subject can then be individually edited. Planning of band 
and subject frequencies prior to selecting subjects for a grid will simplify this process. 

Note: Subjects cannot be deleted from this list if preferences have been recorded for the 
subject. 
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ACTIVITY  

Timetabling > Timetabling Setup > Individual Grid Parameters > Period Structure 

• Select 2020 and the Year 8 grid 

• Click on the green tick to make this grid the default 

• View the Cohort and Period Structure tabs 

Note: We could edit Grid Period Times and Grid Period Labels if we wished.  It is also 
possible to make particular periods unavailable to the selected grid by clicking in the 
relevant cell 
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ACTIVITY 

Add subjects to the Year 8 grid. 

Timetabling > Timetabling Setup > Individual Grid Parameters > Subjects 

• Select the Year 8 grid 

• Click on the Subjects tab 

• Click Add  

• Enter 8 into the Subject Code field 

• Check Find Active Subjects only  

• Click Find 
 

 
 

• Click Select and Yes 
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Edit subject defaults 

• Highlight English 

• Click Edit  
 

 
 

• Use the blue arrow keys to decrease the frequency to four 

• Click OK 
 

• Decrease the frequency of Italian to two  

• Increase the frequency of Mathematics to four 
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• Change to the Year 9 grid 

• Add  the active Year 9 subjects 

• Edit  Art, Craft, Drama, Fabrics, Food, Media, Metalwork, Music and Woodwork so 
that they can only be placed in Bands 9 and 10 

 

 
 

 

• Edit Health Education, Indonesian, Italian and Physical Education so that it can only be 
placed on Bands 6,7 and 8 

 

 

Note: Editing subject frequencies in Timetabling > Timetable Setup > Individual Grid 
Parameters only makes the changes for the selected grid.  Global changes need to be 
made in General > Parameters > Subjects. 
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• Filter to the 10 grid 

• Click Clone  
 

 
 

• Highlight 2019-10 and click OK 
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6.10.4 Grid Subject Groups 

Timetabling > Timetable Setup > Individual Grid Parameters > Subject Groups 

A Subject Group defines a set of subjects that may be allocated to students therefore making bulk 
allocation of preferences easier. This tab allows the user to set up groups of subjects already made 
available to the grid in the previous screen for bulk allocation to groups of students or individuals. 
Subject groups may be deleted at any time without affecting the timetabling process. 
 

 
  



 
Integris Timetable Construction   

Page 150 of 248 

© 2019 Civica Pty Ltd 
 

 

ACTIVITY 

Set up a group of required subjects for Year 8 students. 

Timetabling > Timetable Setup > Individual Grid Parameters > Subject Groups 

• Select Year 8 grid 

• Click Add  

• Enter the Subject Group name – 8REQ - and click OK  
 

 
 

• Highlight all subjects, except, Indonesian and Italian, and click on the red chevrons (arrows) 
pointing right 

 

• Add the following subjects to 9REQ 
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Grid Rooms 

Timetabling > Timetable Setup > Individual Grid Parameters > Rooms 

All rooms previously entered in the Administration module and made available to the cycle will 
appear here to be selected unless already dedicated to another grid.  A dedicated room is defined 
as a room that has been linked exclusively to a particular grid and, once the room has been 
dedicated, it cannot be used in another grid.  Rooms may be made unavailable to a grid if desired.  
The rooms once selected must be defined as either dedicated (only available to this grid) or shared 
with other grids. 
 

 

Note: A room may not be deleted from the list and can only be made unavailable.  If a room 
will not be used by any grid during the timetabling year, it can be deleted from the cycle. 
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ACTIVITY  

Make classrooms MS1 to MS10 unavailable the 10 grid. 

Timetabling > Timetable Setup > Individual Grid Parameters > Rooms 

• Select the Year 10 grid 

• Click on the Rooms tab 

• Click on the Room Code column header  

• Highlight MS1 to MS8 and click Toggle Availability 
 

 
 

Make classrooms SS1 to SS10 unavailable the Year 8 grid  

• Select the Year 8 grid 

• Click on the Room Code column header twice 

• Highlight SS1 to SS9 and Toggle Availability 
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6.10.5 Grid Staff 

Timetabling > Timetable Setup > Individual Grid Parameters > Staff 

The list of teaching staff to be made available to the grid will appear on this screen.  The list will 
initially default to all staff made available to the cycle excluding teachers already dedicated to 
another grid.  A dedicated staff member is defined as a staff member that has been linked 
exclusively to a particular grid and once the staff member has been dedicated he or she cannot be 
used in another grid.  Teachers on the list may be flagged as available/unavailable and 
dedicated/shared.  Once the list of staff has been defined, each member may have non-teaching 
activities recorded against their FTE as defined in Staff Availability to the cycle.  A staff availability 
mask is available to define those periods in the structure the teacher is available to teach. 
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ACTIVITY 

Joseph Brigg, Jennifer Calvin, Nicholas Creed, Travis Elliot, Luke Evans, Edna Everage 
and Amanda Fisher are all Middle School specialists.  Make them unavailable to the 10 
grid. 

• Filter to the Year 10 grid 

• Click on the Staff tab 

• Highlight the names of the Middle School specialists  

• Click Toggle Availability 
 

 
 

Travis Elliott will be dedicated to the Year 8 grid and unavailable on Fridays. 

• Filter to the Year 8 grid 

• Highlight Travis Elliot and click Edit Grid Availability 

• Check the Dedicate to Grid box 
 

 
 

• Click on each of Friday’s teaching periods  

• Click Close 
 
The selected teacher will now show Partial Availability. 
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6.10.6 Grid Band Allocation 

Timetabling > Timetable Setup > Individual Grid Parameters > Band Allocation 

Band Allocation allows the user to change or add schedules to the grid. Once the grid has been 
saved to the timetable, band allocation may not be changed. Common band allocation may show 
two semesters or four terms within the same grid. 
 

 
 

Changing Schedules 

• Select the appropriate school year and grid 

• Click Band Allocation tab 

• Click on  

• Confirm your intention 
 

 
 

• Highlight an appropriate schedule 
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• Click OK 
 

Adding Schedules 

• Select the appropriate school year and grid 

• Click on the Band Allocation tab 

• Click  

• Highlight an appropriate schedule 
 

 
 

• Click OK 
 

• Click on the bands you want to make available or unavailable to a given schedule 
 

 
 

Note: You may only add future schedules to Band Allocation.  Bands may be allocated to all 
schedules or to one only. 
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ACTIVITY 

Timetabling > Timetable Setup > Individual Grid Parameters > Band Allocation 

• Ensure the Year 8 grid is still selected 

• Click Change Schedules  

• Click Yes 

• Select Terms 1 to 4  
 

 
 

• Click OK  

• Allocate bands to the desired schedules by clicking in the appropriate cells 
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• Change the Year 9 grid band allocation to Semesters 1 and 2 

• Allocate Band 9 to Semester 1 only and Band 10 to Semester 2 only 
 

 
 

 
 

6.11 Review 

ACTIVITY 

Note the pathway you took to complete each of the following tasks 

1. Clone the Year 7 grid from 2019 and make the following changes. 
 

 
 
 
 
 
 
 
 
2. Clone all the Year 7 subjects from 2019 to the 2020 - Year 7 grid. 
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3. Create a Subject Group called 07REQ 
 

 
 
 
 
 
 
 
 
 
4. Make the Senior School classrooms unavailable to the Year 7 grid. 
 
 
 
 
 
 
 
 
 
5.  Show Nora Swiderski as only available to the Year 7 grid and unavailable on Wednesday 

afternoons. 
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6. Change Schedules for the Year 10 grid 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

6.12 Student Preferences 

Timetabling > Preferences  

Student Preferences are a list of subjects in a ranked order that a student has selected to study.  
 
Preferences may be entered and maintained for either individual students or groups of students.  
Once the timetable has been created student courses may be altered individually if required.  
Preferences will be ranked by the following classifications: 

• Required – all ranked as 1 and must be allocated  

• Primary Electives – ranked in ascending order  

• Reserve Electives – those subjects nominated by the student in case any of his or her primary 
electives are disallowed  

 
Preferences for a student will apply to a grid.  If a student is a member of more than one cohort, 
preferences will have to be entered for each grid.  Student preferences may be allocated via a 
combination of both bulk and individual entry.  For example, all required subjects may be entered 
via the bulk entry screen and electives may be entered individually. 
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Note: Prior to entry of student preferences, subjects and/or subject groups must be defined 
for the associated grid.  If no subjects have been defined for the grid, the user will be 
unable to enter student preferences. 

Learning Area Analysis reports may also be viewed from the student preference screen. 
 
Student Preferences may be entered by 

• Individual entry 

• Bulk entry of preferences  

• Promotion of some or all of a student course from any earlier grid 
 

6.12.1 Individual Entry of Preferences 

Timetabling > Preferences > Preferences by Student 

To select one or more students for individual entry of preferences, highlight the students within the 
Preferences by Student window and click on the View Details icon. 
 
For each student individual preferences are entered by dragging subjects from the subject list or 
typing the subject code and ticking the required box as necessary. Preference order may be 
changed up or down as required.  If a browse set has been chosen i.e. a group of students 
highlighted from the cohort list, use the blue arrows to move between the selected students. 
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Add preference 
 

Edit Preference 
 

Add subject group 
 

Delete preference 
 

Toggle Reserve/Primary 
 

Place in T-set  
 

Remove from T-set 

 

Note: Students must be included in a cohort and subjects allocated to the grid prior to entry 
of preferences. 
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ACTIVITY 

Enter the subject preferences for the following students in Year 9 in 2020.  English, 
Maths, Physical Education, Science, and Society and Environment are required subjects.  
Their electives are listed below. 

Timetabling > Preferences > Preferences by Student 

Mark Antonello: Art and Food, and in reserve Metalwork and Music 
Alecia Bishop: Food and Woodwork, and in reserve Drama and Music 
 

• Ensure 2020 is selected 

• Select the Year 9 grid. 

• Highlight Mark and Alecia to create a browse set 
 

 
 

• Click View Details 

• Click on Show/Hide Subject List 

• Highlight the group 9REQ and drag onto the preferences window 
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• Drag and drop the other preferences 
 

 
 

• Highlight the reserve subjects and click on the Toggle Reserve/Primary button  
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• Use the blue chevron  to move to Alecia and add her preferences. 
 

 

Note:  Reserve, and unallocated, preferences are displayed in red.  

• Close Individual Student Preferences 
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6.12.2 Bulk Entry of Student Preferences 

Timetabling > Preferences > Bulk Student Preferences 

Preferences may be entered in bulk by defining a list of subjects or subject group and groups of 
students to which they may be allocated.  
 
Courses may be promoted from last year via the course promotion screen.  To be promoted these 
courses must have been previously defined in Timetabling > Timetable Set-up > Maintain Course 
Promotion Table.  Courses may be promoted from a previous year or semester grid.   
 

   
 

Adding preferences in bulk to a group of students 

• Highlight students in the cohort and click on the arrows 

• Highlight the required subjects and click on the arrows 

• Click Add 
 

Removing preferences in bulk from a group of students 

• Highlight students in the cohort and click on the arrows  

• Highlight the required subjects to be removed and click on the arrows  

• Click Remove 
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ACTIVITY 

Allocate Indonesian 9 to selected Year 8 students moving into Year 9 in 2020. 

Timetabling > Preferences > Bulk Student Preferences 

• Ensure 2020 School Year and Grid 2020-09-09 

• Click Select Students  

• Find those students studying Indonesian this year 
 

 
 

• Click Find, Select and Yes 

• Move the selected students to the right 

• Move Indonesian 9 to the right 

• Click Add 
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Add Italian 9 as a preference to all students who studied Italian this year 

 

 
 

Allocate the required subjects 8REQ to all Year 7 students. 

• Select the Year 8 grid 

• Highlight all of the students 

• Click on the arrow  

• Highlight Year 8 Required Subjects 

• Click on the arrow  
 

 
 

• Click Add 
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Allocate a language to all Year 7 students 

• Find the students who have studied Indonesian this year and move them to the right 
 

 
 

• Move Indonesian 8 to the right 

• Click Add 
 

• Allocate Italian 8 to the students who studied Italian this year 
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Promoting Student Courses 

The promotion of student courses from a previous grid is initiated from within the Student 
Preference > Bulk Entry Window 
 

• Click Promote Courses from a Previous Grid 
 

  
 

• Highlight the appropriate grid and click OK  
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Note:  There is an option to retain all teaching sets.  

 
 

• Edit as required 

• Click OK   
 

 

Allows the user to deselect students from course promotion 
 
Allows the user to deselect subject from course promotion 
 
Allows the user to select which teaching sets are to be retained 
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ACTIVITY 

Promote all Year 8 students to selected Year 9 courses. 

Timetabling > Preferences > Bulk Student Preferences tab 

• Select Year 9 grid  

• Click on Promote Courses from a Previous Grid  

• Highlight 2019 08  
 

 
 

• Click OK 

• Click on each of the toolbar buttons to see what they do 
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• Select Home Room and click Retain Teaching Set Groups  

• Check Retain Group for each Set 

• Click OK 
 

 
 

• To promote all courses, click OK 

• Close the Preferences window 
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Trainers use Datafile 2 

 

ACTIVITY 

 
File > Change Datafile > Open existing 
datafile\C:\keys\Integris\RMDB\TrgData2\Integris.df2 
 

• Log in with User Name Admin 

• Password Keys 
 

 
 

•  
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6.13 Validating and Verifying Preference Entry 

A number of tools are available to validate student preference entry prior to initiating the Grid 
Modelling process.  
 
The Preference by Student window displays the number of preferences entered for each student. 
This list can be sorted on column headers so that students with too few or too many preferences 
can be examined. 
 

 
 
Other reports are available from Timetabling > Reports > Data Validation Reports.  Samples of 
all of these reports may be viewed in the Timetabling Manual.  
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ACTIVITY 

Timetabling > Preferences > Bulk Student Preferences 

• Select 2020-09 and Bulk Student Preferences 

• Click on to column heading No.Prefs  
 

 
 

• Highlight the students with fewer than 10 preferences and move them to the right 

• Highlight the 9REQ subject group and a language and move them to the right 

• Click Add  
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Timetabling > Reports > Data Validation Reports > Student Course Summary  

• Select the TT Year 2020 

• Select the Middle School Campus 

• Select One student per page 

• Use Find to select three Year 8 students 
 

 
 

• Print the report to the screen 
 

• Repeat but select Multiple students per page 
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Timetabling > Reports > Data Validation Reports > Students Choosing a Subject 

• Select the TT Year 2020 

• Select the Middle School Campus and 2020-09 Grid 

• Check Include Reserve Preferences 

• Find to select the Active subjects attached to the Art department 
 

 
 

• Print a report on students choosing an Art subject 
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Timetabling > Reports > Data Validation Reports > Preferences for Students Choosing a 
Subject 

• Select the TT Year 2020 

• Select the Middle School Campus and 2020-09 Grid 

• Check Include Reserve Preferences 

• Find to select the Active subjects attached to the Art department 
 

 
 

• Print a report on students choosing an Art subject 
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6.14 Subject Load Table 

Timetabling > Preferences > Subject Load Table 

A subject load table is maintained for each grid and contains a summary of the information relating 
to each subject made available to the grid.   
 
The major function of the Subject Load Table is to present information that will allow the number of 
sets for each subject to be appropriately set.  This decision will be based upon the number of 
primary and reserve preferences selected by students and the availability of staff and room 
resources.  Non-viable subjects may also be identified in this process with the resultant need to 
refit affected students. 

Note: Grid modelling of teaching sets is not possible until the number of teaching sets to be 
made available has been defined  

By default, the table will display subjects made available to the grid that have student preferences 
recorded.  By clicking on the Show/Hide No Preferences button all subjects made available to the 
grid will be displayed. 
 

  
 
The table will display all defined subjects for the grid including such information as how many 
students have elected the subject as a primary or reserve preference, the default minimum and 
maximum class size, the default frequency, whether it is a required subject and a number of 
unallocated places left in the class.  Using this information, the number of teaching sets for each 
subject may be planned and edited.  From this screen, the number of teaching sets required, 
default class sizes, frequency of the classes and whether the subjects are required, may also be 
edited.  The other fields are populated based on information from this screen and the student 
preferences screens. 
 
Next to the number of teaching sets for a subject is a button which if clicked will display a list of 
teaching sets for that subject.  The maximum and minimum class size for each set can be 
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individually edited.  To edit the subject details, click on the Edit button and type information into a 
selected cell. 
 
At the bottom of the screen a series of totals are displayed.  The number of students is the total of 
students defined in the cohort.  Students with no preferences shows the number of students in 
the cohort but with no preferences listed.  Underloaded students lists the number of students who 
do not have a full study load.  Number of subjects lists the total number of subjects defined for the 
grid.  Singletons lists the number of subjects with only one teaching set.  Multi-set shows the 
number of subjects with more than one teaching set.  Number of proposed sets lists the number 
of all teaching sets defined for this grid.  Number of proposed periods shows the number of all 
teaching periods defined for this grid. 
 
The confirmation or editing of subject frequencies may be defined in one of three places.  The 
frequency may be entered when defining the subjects for a particular grid (Timetabling > Timetable 
Set-up > Individual Grid Parameters > Subjects) or it may be edited in the subject load table 
(Timetabling > Preferences > Subject Load Table) or within the vertical grid view of grid modelling 
(Timetabling > Grid Modelling > Vertical View). 
 

Note: The Auto scheduler makes use of maximum and minimum teaching set sizes to 
determine the placement of teaching sets on the grid.  Always check that entered values are 
correct.  Once the grid has been modelled and saved as a timetable, changes made to the 
minimum and maximum class sizes will not affect the number of teaching sets.  Any 
changes to class sizes must be completed prior to grid modelling either manually or using 
the auto-schedule process. 

 

6.14.1 Collapsing Non-Viable Subjects 

The timetabler may identify subjects that have been made available to the grid but are considered 
not viable to operate within the timetable being constructed.  A number of factors will be 
considered, one of which is the number of students selecting the subject as a primary or reserve 
preference. 
 
If the number of sets for these subjects is set to zero within the load table, then teaching sets of 
these subjects will not be available to the grid modelling process for manual or auto scheduler 
placement.  However, if student preferences are not adjusted then the student will ultimately 
remain unplaced.  To identify the students involved, print the report Students Choosing a Subject 
from the Reports menu within the timetabling sidebar.  These students can then be individually 
selected and edited within the Preference function or the subject can be removed from all students 
using Bulk Allocation > Remove. 
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ACTIVITY 

Timetabling > Preferences > Subject Load Table 

• View Teaching Sets entered for the subject load table for Year 8   
 

• Filter to the Year 9 grid  

• Click Edit 

• Enter the required number of teaching sets for all subjects (<Tab> to navigate to the next 
teaching set) 

 

 

Note: Minimum and maximum class sizes may be edited.  Use <Tab> to navigate through 
the screen.  

• Click OK and Yes  

• Print to screen and view the report 
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6.15 Review 

ACTIVITY 

Note the pathway you took to complete each of the following tasks 

1. Promote the following subjects from Year 9 to Year 10. 
 

 
 
 
 
 
 
2. Promote these subjects from 2020 Year 9 to 2020 Year 10.  Retain the Home Room groups.  
 
 
 
 
 
3. Add Health Education as a subject for next year for all next year’s Year 10s (the current Year 

9s). 
 
 
 
 
 
4. Add Indonesian and Italian 10 as subjects for next year to all of the current Year 9s who are 

studying those languages this year. 
 
 
 
 
 
5. Enter the number of teaching sets required for the 2020 – 10 grid 
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6.16 Grid Modelling 

Timetabling > Grid Modelling 

Construction and manipulation of the grid is referred to as grid modelling.  
 
A comprehensive set of tools is available to the user to assist with the modelling process.  The Grid 
Modelling screen will allow definition of constraints to be applied to a particular grid and the 
construction of the grid allowing for defined constraints.  
 
The grid may be developed in one of three ways: 

• Manually placing all elements on the grid and generating nothing (that is creating a fixed grid) 

• Manually placing some elements on the grid and automatically generating the rest of the grid 
around the fixed elements or 

• Automatically generating the entire grid 
 
Although each grid is modelled individually, the grid modelling process will also consider the links 
between different grids and the allocation of grids to schedules.  Each of these processes can be 
manually controlled or in some cases can be left to the auto scheduler and then edited. 
 
Timetablers constructing a Fixed Grid Timetable will create the grid using manual construction 
without the need for the auto scheduler and many of the features described below will not be 
needed. 
 
The following reports may be useful in the execution of grid modelling: 

• Student Fit Report 

• Load Table  

• Conflict Matrix Report  
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6.16.1 Unlocking the Grid 

Timetabling > Grid Modelling > Unlock Grid 

Upon entry of the grid-modelling screen, the user will be prompted to unlock the grid.  No changes 
may be made to the grid until it is unlocked.  Unlocking the grid takes a snapshot of the grid so that 
the timetabler can revert to the initial position. 
 
Multiple snapshots may be taken of the grid at any time and then changes made.  The user may 
later retrieve a snapshot and revert to a previous snapshot if required.  Student Fit Statistics may 
be viewed to note the effect of changes and to highlight problem bands and/or subjects. 
 
The screen will open in the Horizontal View 
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Indicates the band is locked 
 
Indicates the band is unlocked 
 
Allows bands to be expanded to band records  
 
 
Indicates that the grid has been saved to the timetable 

 

Timetabling > Grid Modelling > Display Teaching Sets 

Teaching sets may be manually placed on the Bands or Band Records.  To display a list of 
available teaching sets, click on Display Teaching Sets.  
 

  
 
A list of teaching sets will appear on the left-hand side of the window. 

Note: If no teaching sets appear, check that the number of teaching sets required for each 
has been entered in the Subject Load Table. 

Teaching Sets may be dragged and dropped onto relevant bands or band records.  The action of 
placing sets onto the grid in a particular cell will fill the band records up to the subject frequency if 
the subject frequency is less than or equal to the band frequency.  If the subject frequency of the 
set is greater than the band record, the user will still be able to place the teaching set but a warning 
message will occur and the user may decide to either change to another band record with a 
greater frequency or change the frequency of the band or subject. 
 
Teaching sets may also be typed into the box and a band or band record selected by clicking in the 
cell and clicking the green tick to place the teaching set. 
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All manually placed teaching sets will be marked as Fixed Elements (F) and as such will not be 
moved by any auto scheduling process unless marked as not fixed (see below). 
 
Once a teaching set has been allocated to a band or band record, right clicking on the cell will 
produce a menu listing the following options: 
 

  
 
The first three options will only be available if the band/band record is unlocked. 
 

Adding a Teaching Set within Grid Modelling 

If additional teaching sets are needed once the grid modelling process has begun, it is not 
necessary to return to the Subject Load Table.  Additional teaching sets may be added or deleted 
by selecting Tools > Add Teaching Set or Delete Teaching Set.  Subject Load Table details will 
be automatically updated.  At the time of adding a teaching set, the user will be prompted to add 
students to the teaching set.  The students may be added here or later through the Move Student 
function. 
 

Moving a Teaching Set 

Moving teaching sets from one band to another may be necessary to resolve an unrecognised 
resource conflict or to improve the fit of students.  Any movement of a teaching set is likely to result 
in students who previously fitted the subject becoming unfitted due to a clash and students who did 
not previously fit the grid to now fit.  The timetabler must ensure that students affected by this 
move are refitted prior to closing the grid.  Several moves can be made prior to identifying and 
resolving these clashes. 
 

To move a teaching set 

Right click on the selected set, and choose Move Teaching Set   
Select the appropriate option and then click on OK 
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• Select the band that the teaching set is to be moved to and then click on OK  
 

 
 
The teaching set will be moved and placed onto the band selected. 
 

6.16.2 Placement of Students 

Timetabling > Grid Modelling > Tools > Move Students  

Once teaching sets have been manually placed on the grid, the user may choose to automatically 
allocate students to teaching sets based on their previously entered preferences or to manually 
place students as the user sees fit.  
 
Manual Placement of Students is completed by choosing Tools > Move Students > Unplaced 
Students, highlighting the appropriate teaching set, selecting the relevant students and selecting 
Place.  
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Checking for Conflicts 

To check the fit of students to the grid following one or more moves on the grid: select Check for 
Conflicts from the Tools menu.  Select students to be checked and click Check for Conflicts.  
Conflicts will be identified. 
 

   
 
Conflicts are resolved by clicking on Resolve Conflicts.  This could result in students with clashing 
teaching sets being removed from one of the teaching sets and being placed in another or 
becoming unfitted. 
 
Unfitted students should then be placed by choosing the Fit All Students function from the tools 
menu.  A summary of moves made will be displayed at the end of the Fit process and the 
timetabler can accept or cancel the changes. 
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The Update Student Fit Statistics  is a useful tool for determining the effect of students moving 
teaching sets.  The number of students fitted to each band or band record as well as student 
placement statistics are available when this option is selected. 
 

6.16.3 Locking/Unlocking Bands 

Timetabling > Grid Modelling > Tools 

Bands may be locked or unlocked at any time by selecting Tools > Lock all Bands or Unlock all 
Bands.  Once a band has been locked only limited functions are available and the contents of the 
band are protected.  For a full selection of tools to be available the band must be unlocked.  
 

6.16.4 Horizontal View 

Timetabling > Grid Modelling 

There are two ways of viewing the Grid Modelling screen – Horizontal and Vertical.  Some tools 
and functions are available from both views, others only from one view. From the Timetabling 
sidebar, select Grid Modelling and the following window will appear:  
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6.16.5 Vertical View 

Timetabling > Grid Modelling > Switch View 

To change to Vertical view, click on Switch View and Vertical view.  
 
The following window will appear:  
 

 
 
The first number indicates the number of the teaching set.  The number in brackets shows how 
many students there are in that teaching set. 
 

6.16.6 Fixed Grid Elements 

Timetabling > Grid Modelling 

Teaching sets may be manually fixed so that they cannot be moved unless marked as a non-fixed 
element later.  This option is particularly useful if manually placing some teaching sets and then 
auto-scheduling the rest. 
 
To fix a teaching set on the relevant band/band record: right click and from the menu select Mark 
as a Fixed Element the teaching set will be marked as below. 
 

 
 

 The (F) indicates this teaching set is a fixed element. 
 

6.16.7 Locking the Grid  
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Timetabling > Grid Modelling > Lock Grid 

Upon exiting the grid-modelling screen, the user will be prompted to lock the grid and to save 
changes made or not.   
 

The user must lock  the grid prior to exiting this window. 
 

ACTIVITY 

Timetabling > Grid Modelling 

• Filter to the Year 8 grid for 2020 

• Unlock the grid  

• Click Display Teaching Sets  

• Click on, drag and drop teaching sets onto the grid  
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Placing Students 

Timetabling > Grid Modelling > Tools > Move Students > Unplaced Students 

• Click Fit All Students 

• Select Ignore students in off-grid sets and click OK  
 

 
 

• Accept changes by clicking OK 

• Close Move Student window 

• Click Update Statistics  to check that all students have been placed 
 

 

6.17 Inter-grid Linkage 

Timetabling > Grid Modelling > Functions > Inter-grid Linkage 

The Inter-grid Linkage table is used to link band records from different grids into common time 
slots.  Time slots link to the period structure that was previously created for the cycle and grid. 
 
The user may populate the inter-grid linkage table in one of three ways: 

• Manually linking all bands on the table and generating nothing 

• Manually linking some bands containing fixed elements on the table and automatically 
generating the rest of the table around the manually placed bands  

• Automatically generating the entire table 
 
If the Inter-grid Linkage table is being manually populated, this may be done prior to or after the 
population of grids with teaching sets.  Completing the Inter-grid Linkage table early will enable the 
timetabler’s plans to be recorded and resources more readily tracked.  
 
The Inter-grid Linkage table will be created for the entire timetabling year, with each schedule 
appearing within it.  The table may be filtered by schedule so that all grids with concurrent band 
records may be displayed in isolation. 
 
Selecting Timetabling > Grid Modelling and unlocking the grid and then clicking on the 
Functions menu and choosing Inter-grid Linkage table will display the following screen: 
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To add another time slot, click on add a slot.    A time slot will be added onto the end of the 
existing slots.  The new slot will be available for all grids. 
 
Right clicking on an individual cell will produce the following menu. 
 

 
 
Display Teaching Sets will list all teaching sets associated with the band record. 
 
Mark as Unavailable will highlight the slot as unavailable and no band record will be able to be 
placed on the slot until it is made available by right clicking and selecting Make Available. 
 
Unlink Slot will delete any band record linked to the slot 
 
Unlink All Slots in Schedule will delete any band record linked to all slots 
 
The last three functions will only be available if the grid has not been saved to a timetable. 
 

Note: Best practice would indicate that all schedules be completely linked together before 
saving so that the user can check that the timetable can be resourced. 
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ACTIVITY 

Timetabling > Grid Modelling > Functions > Inter-grid Linkage 

• Click on Show Band Record Display   

• Select 2020-08 and Term 1 

• Filter to Term 1 

• Drag the Band Record into the desired slot, as shown below 
 

 
 

• Complete mapping band record to slots by dragging the band records and dropping then into 
the desired slots  

 
(See the table below for an explanation of how Band Records are to be assigned to Slots1 to 29.) 
 

• Close the window 
 

 

Inter-Grid Linkage Table/Timeslot Mapping for Year 8  

 Monday Tuesday Wednesday Thursday Friday 

 Slot 
Band 

Record 
Slot 

Band 
Record 

Slot 
Band 

Record 
Slot 

Band 
Record 

Slot 
Band 

Record 

Home 
Room 

1 1.1 2 1.2 3 1.3 4 1.4 5 1.5 

Lesson 1 6 2.1 11 7.1 16 5.2 21 4.3 25 3.4 

Lesson 2 7 3.1 12 2.2 17 9.1 22 5.3 26 8.2 

Lesson 3 8 6.1 13 3.2 18 2.3 23 7.2 27 4.4 

Lesson 4  9 4.1 14 8.1 19 3.3 24 2.4 28 5.4 

Lesson 5 10 5.1 15 4.2 20 6.2   29 9.2 
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6.18 Time Slot Mapping 

Timetabling > Grid Modelling > Functions > Time Slot Mapping 

Time Slot Mapping is the act of mapping Band Records to the Period Structure. 
 

 
 
Time slots may be dragged and dropped around the period structure.  If the time slot is dragged to 
an already populated cell, a warning message will appear before swapping the contents of the cell.  
Right clicking on the time slot will display View Slot Details; if this is clicked a window will appear 
that allows the user to view information about the grid, schedule and band record for that particular 
time slot.   
 

 
 
Saving the time slots will store the row labels, days and row numbers for this grid. 
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Note: The time slots may be changed at any time and can be completed before the grid has 
been completely modelled. 

 

ACTIVITY 

Timetabling > Grid Modelling > Functions > Time Slot Mapping 

Map slots to the period structure. 

• Click on an unmapped time slot 

• Drag it to an appropriate cell 

• Repeat until all slots are mapped  

• Click Save and Close 
 

 

Please note: Consideration will need to be given to the subjects placed onto bands and the 
inter-grid linkage table when planning how to map timeslots. 
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Timetabling > Grid Modelling > Functions > Inter-Grid Linkage Table 

 
 
The slots in the inter-grid linkage table are mapped to the period structure. 
 

• Close the window 

• Lock  the Year 8 grid 
 

 
 

• Click Yes 
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6.19 Entering Auto-scheduling Constraints 

Timetabling > Grid Modelling 

The following constraints are only useful if the auto-scheduling process is to be used.  The 
constraints are optional but if used, may produce a better timetable with optimal use of fixed 
resources. 
 

6.19.1 Fixing Grid Elements 

It is possible to fix and lock Teaching sets and Bands manually.  The effect of fixing and locking will 
signal to the auto-scheduling process to work around these fixed elements while continuing to 
assess conflicts by placing teaching sets and students around these elements. 
 
Teaching sets may be filled manually through Grid Modelling > Tools > Move Students.  Students 
will be able to be added to a set either from an existing set or from the cohort list.  Once students 
have been added to a set they may then be locked into the set.  If a student is locked into a set 
they cannot be moved out of the set either manually (unless the set is unlocked) or by the auto-
scheduling process.  Teaching sets may also be filled automatically through the Tools > Fit All 
Students function. 

Note: Students may be manually added to Teaching Sets in two other areas:  
Timetabling > Preferences > Teaching Sets or 
Timetabling > Timetable > Functions > Move Student. 

 

6.19.2 Subject Constraints 

Timetabling > Grid Modelling > Grid Constraints 

Users may define subject constraints before a timetable is generated.  Constraints are used by the 
auto-schedule process, but will also be used for validation during manual placement of fixed 
elements. 
 
Constraint categories are: 

• Keep Together Sets – sets which must occur at the same time 

• Keep Apart Sets – sets which must not occur at the same time 

• Linked sets – sets that must have the same membership of students 
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ACTIVITY 

Timetabling > Grid Modelling > Grid Constraints >Keep Together 

9Eng_1 and 9HASS_2 are to be scheduled at the same time. 
 

• Filter to the Year 9 grid and tick the green tick to make it the default grid 

• Unlock 

• Select Grid Constraints and Keep together 

• Click Add Constraint  

• Give the constraint a name and click OK 
 

 
 

• Highlight 9Eng_1 and 9HASS_2 in the Available Teaching Sets list 

• Click Add Selected Teaching Sets  
 

Timetabling > Grid Modelling > Grid Constraints > Keep Apart 

9ITAL_1 and 9ITAL_2 are to be scheduled at different times. 

• Click Add Constraint  

• Give the constraint a name and click OK 
 

 
 

• Highlight 9ITAL_1 and 9ITAL_2 in the Available Teaching Sets list 

• Click Add Selected Teaching Sets  
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Timetabling > Grid Modelling > Grid Constraints > Linked Sets 

9-4 is a TAGS group.  We want to ensure that these students are in the same teaching set for 
each of their MESH subjects. 
 

• Select the Linked Sets tab 

• Click Add Constraint  

• Give the constraint a name and click OK 

• Highlight 9Eng_4, 9Math_4, 9HASS_4, and 9Sci _4 in the Available Teaching Sets list 

• Click Add Selected Teaching Sets  
 

 
 

• Close Constraints  
 

 
  



 
Integris Timetable Construction   

Page 202 of 248 

© 2019 Civica Pty Ltd 
 

 

6.19.3 Fixing Grid Elements 

It is possible to fix and lock Teaching sets and Bands manually.  The effect of fixing and locking will 
signal to the auto-scheduling process to work around these fixed elements while continuing to 
assess conflicts by placing teaching sets and students around these elements. 
 

ACTIVITY 

Timetabling > Grid Modelling 

• Click Display Teaching Sets  

• Drag and drop the HR teaching sets onto Band 1  

• Drag and drop the 9-4 teaching sets onto Bands 2 to 5 
 

 
 
 

 

6.19.4 Manual Teaching Set Allocation 

Timetabling > Preferences > Teaching Sets 

Teaching set allocation will often be performed by the auto-scheduling process, or using Student 
Fit functions within Grid Modelling.  However, students may be manually placed in a teaching set 
and locked.  These will be respected by the auto-scheduling process and student fit functions and 
will not be re-allocated.  Students must have been allocated preferences before being manually 
placed in a related teaching set.   
 
Teaching set allocation may be completed in one of three ways: 
 

• Completely allocated by the auto-scheduler or Student Fit functions 

• All teaching sets manually allocated  

• A combination of manually allocated teaching sets and using the auto-scheduler 
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Note: There are two further opportunities within the Move Students function to manually 
place students in teaching sets:  

Timetabling > Grid Modelling > Tools > Move Students 

Timetabling > Timetable > Functions > Move Students 

 

ACTIVITY 

Timetabling > Grid Modelling > Tools > Move Students > Unplaced Students 

• Select English 9 in the left-hand pane 
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• Click Select Students  

• Find the students in Form 8.4 
 

 
 

• Click Select and OK when asked if you want to continue 

• Click Place and OK 
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• On the Unplaced Students tab, select Home Room 9 in the left-hand pane 
 
Most students have been promoted into their Home Rooms. 
 

 
 

• Select Oliver Brown in the centre pane and 9HR_3 in the right-hand pane 

• Click Place 

• Repeat until all students have been placed in a Home Room 

• Save then Close Move Students 
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6.19.5 Locking Sets 

Students may be locked into teaching sets, which they cannot be moved from those sets during 
auto-scheduling, or the sets themselves may be locked so that no one can be moved in or out. 
 

ACTIVITY 

Timetabling > Grid Modelling 

• Right click in the cell containing 9Eng_4 

• Select Show Teaching Set Members 
 
The students may be locked into this teaching set.  This would mean that that the auto-scheduler 
could not remove them from this set or the linked sets.  It could, however, place other students 
into the linked sets. 
 

• Close Teaching Set Members 

• Right click in the cell containing 9Eng_4 

• Select Lock Teaching Set 
 

 
 

• Read the message and click Yes 
 
Now the auto-scheduler cannot move students into or out of the linked sets. 
 

 

6.19.6 Locking Bands 

Locking an entire band ensures that no changes may be made to that band during auto-
scheduling. 
 

ACTIVITY 

Timetabling > Grid Modelling 

• Click on the padlock on Band 1 to close it 
 

 
 
No changes can now be made to that band. 
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6.20 Auto-schedule Process 

The auto-schedule process will create a grid that optimises the fit of student preferences, taking 
into account user nominated constraints on subjects and teacher and room resources. 
 
The following constraints can be selectively applied during the auto scheduling process: 
 

 Mandatory Desirable Optional 

Number of Sets of a Subject ✓   

Maximum and Minimum Class Sizes ✓   

Matching Subject and Band Frequencies ✓   

Resource Usage of other Grids  ✓  

Staff Preferred Subjects  ✓  

Subject Preferred Rooms  ✓  

Inter-Grid Linkage  ✓  

Keep Apart Sets   ✓ 

Keep Together Sets   ✓ 

Linked sets   ✓ 

Locking students in Sets   ✓ 

Locking Sets   ✓ 

Locking Bands   ✓ 

 

Note: The mandatory constraints will be applied, and should be checked by the timetabler 
prior to initiating the auto scheduling process.  Incorrect or incomplete constraints may 
result in unacceptable solutions. 

 
The auto-schedule process will function as a wizard requiring the user to nominate various settings 
within three screens before the process begins.  The fourth screen is displayed while the auto-
scheduler is in process.  A user may cancel the auto-schedule process at any time by clicking 
Cancel from any of the first three screens or <Ctrl + Break> and then clicking Cancel in the fourth 
screen.  At certain stages of the auto-schedule process cancelling may corrupt the data file, if this 
is the case a warning will be displayed on the screen to that effect. 
 
In screen one the user may select previously defined constraint settings (that is linked sets, keep 
apart sets or keep together sets).  The user may also elect to use threshold settings and resource 
monitoring for teachers and rooms.  Resource monitoring can only be selected if staff preferred 
subjects and/or subject preferred rooms has been entered.  Threshold settings allow the user to 
fit the timetable even if teachers and/or rooms are a nominated amount short.  Resource 
monitoring, if ticked, will allow the user to monitor the placing of teachers and/or rooms.  
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Screen 2 will display a list of related grids that have the potential to share resources with the 
current grid.  If the user wishes, the auto-schedule process to take into account resources from 
other grids the relevant grids must be included.  The inter-grid linkage table may be edited by 
clicking on the Edit Grid Links button.  
 

 
 
Screen 3 allows the user to view the number of available Timetable Cycle slots.  The user may 
also indicate the number of possible solutions required and the variants of the main solution may 
also be requested if required. 
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The auto-schedule process completes the following functions in the listed order: 

• Examining Teacher and Room preferences 

• Calculating possible teacher use – Selected Schedules 

• Calculating possible room use – Selected Schedules 

• Making initial allocation of students to teaching sets 

• Assessing initial allocation of students to teaching sets 

• Improving student allocations to teaching sets 

• Examining current Teaching Set to Band assignments 

• Saving newly created timetable details 
 
A completion report is displayed at the end of the auto-schedule process showing any conflicts 
and/or student dropouts created by the process.  The user may then relax or tighten constraints 
and run the auto-scheduler again or accept the result and manually manipulate the grid to produce 
a better grid.  
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Note: The time taken for the auto-schedule process is dependent on the size of the school, 
number of constraints used and the processing capacity of your hardware. 

Manipulation of Auto scheduler Solutions 

Solutions produced by the Auto scheduler can continue to be manipulated using the functions 
available within grid modelling.  Alternatively, constraints and fixed elements may be adjusted and 
the auto scheduler restarted. 
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ACTIVITY 

Timetabling > Grid Modelling > Functions > Autoschedule 

Use the Autoschedule wizard to complete the Year 9 grid  

• Click Functions and Autoschedule   

• In the first screen view edit, if necessary, previously defined constraint settings, threshold 
settings and resource monitoring 

 

 
 

• Click Next   
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• Include only the Term 1 Year 8 grid in resource monitoring and click Next  
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• Enter Number of Possible solutions to generate as 2 and click Next 
 
The Auto-schedule process will commence. Once completed, you may one report per solution on 
the screen or you may print these reports. 
 

 
 

• Click Close 
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Note: The user may manually resolve conflicts or tighten/relax constraints and run the auto-
scheduler again. 

 

6.21 Refining Student Placement 

Once all teaching sets are in place, it is now time to refine student placement for the timetable.  
Student Placement involves ensuring that all students are placed in a teaching set at any one time 
and there are no clashes or unplaced preferences. 
 
This process will involve the use of the Move Student Function to manipulate the placement and 
balance of students within sets of multi-set subjects and the use of the Student Course function to 
manipulate and fit individual students. 
 

6.21.1 Move Student Function 

The Move Student function is available in two places: 

• Timetabling > Grid Modelling > Tools > Move Students 

• Timetabling > Timetable > Functions > Move Students  
 
The Move Student function allows the user to move or redistribute teaching sets, balance all sets, 
view the results of any moves, resolve conflicts and place unplaced students. 
 
Move/Redistribute allows the user to highlight any teaching set and students in the teaching set 
will then be automatically highlighted.  The Move Students option allows the user to highlight any 
or all students and move them to another teaching set for the same subject.  If there is more than 
one destination teaching set available, using the Redistribute function will try to place students 
with the minimum of dropouts.  Remove will remove the teaching set from the grid and any 
students in that set will become unplaced students.  
 

 
 
After any attempted change, the View Results tab will be shown to display the success or failure 
for individual students of any move.   
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The report may be printed from this screen by selecting Print Log.  If Success is listed, the 
student has been successfully moved to the destination teaching set.  If Failed is listed, the 
student has not been moved but remains in their original teaching set.  If Dropout is listed, the 
student is now not placed in any teaching set for that subject and remains unplaced. 
 
Balance all Sets attempts to redistribute students to allow more equitable teaching sets.  Users 
can select some or all teaching sets to be balanced.  Highlighting the relevant teaching sets and 
clicking on Balance Sets will attempt to redistribute the students. 
 

 
 
Once the balancing of the sets has been set in motion, the Graphical Display of teaching sets will 
be automatically displayed.  If the system could balance teaching sets without allowing any 
dropouts, the graph will automatically adjust to reflect the balancing. 
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Conflict Resolution allows the user to select some or all students for a grid and Check for 
Conflicts, that is, check for student clashes.  Any clashes will be listed and the user may Resolve 
Conflicts from this screen. 
 

 
 
Unplaced Students displays any subjects in red that have any unplaced students.  All other 
subjects and placed students are also listed.  Students who are unplaced are listed in red and have 
a U placed next to their name.  The third column displays associated teaching sets for the 
highlighted subject.  Highlighting the appropriate subject(s), student(s) and teaching set(s) and 
clicking Place will attempt to move students into teaching sets.  The Remove function will move a 
placed student from a teaching set.  The Fit All function will attempt to place all unplaced students 
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into relevant teaching sets.  Auto Promote promotes students’ reserve preference, after which Fit 
All may be attempted again.  The success or failure of the attempted placements will be shown on 
the View Results tab that will display automatically.   
 

 
 
If the move has been successful, clicking OK will save the move.  If the move has been 
unsuccessful and the user wants to return all students to their original teaching sets, clicking 
Cancel at any time will not save any changes.  If the user is in the Grid Modelling screen, the use 
of snapshots may be advantageous to check the results of any moves. 
 
Allow Oversize Sets if checked will create teaching sets that are larger than the maximum listed 
in the Subject Load table if this will allow more students to be fitted into the teaching sets.  
Movements shows the number of student moves that have been allowed for this grid.  Attempts 
displays the number of attempted moves to place students on the grid. 
 
The Timetable Year and/or Grid may be changed at any time while working within the Move 
Students function.  
 
Useful reports to view while analysing student fit are the 

• Auto-scheduler Completion Report 

• Student Fit Report 

• Load Table Report  

• Conflict Matrix Report  
 
These reports except for the auto-scheduler completion report are found in Timetabling > Reports 
> Planning and Preparation. 
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ACTIVITY 

To fit as many students as possible to the Year 9 grid:  

Timetabling > Grid Modelling 

• Click Update Student Statistics    
 
This will indicate how many students are unplaced overall and for each band record. 
 

 
 
It is likely that one of the Bands between 2 and 5 will contain five teaching sets and another will 
have only three. 
 

• Ensure all grid bands are unlocked, then right click on the smallest teaching set on the longest 
band and click Move Teaching set 
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• Choose Retain Students in Teaching Set and click OK twice 
 

 
 

• Select the shortest Band between 2 and 5 and click OK 
 

 
 
This is likely to create conflicts. 
 

• Click on Tools > Move Students and select Conflict Resolution 

• Click on Select All and Check for Conflicts 
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• Click Resolve Conflicts and then select the View Results tab to see how the conflicts were 
resolved. 

• Click OK to save the changes 
 
Now some unplaced students may be placed. 
 

• On the Unplaced Students tab, click Fit All 
 

Any subjects highlighted in red have unplaced students.  The students highlighted in red 
are the unplaced students for the selected subject. 
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• Select Ignore students in off-grid sets and click OK 
 
Some students will be placed. 
 

• Click OK to save the changes and close the Move Students window 

• View the stats again 
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• Click on Tools > Move Students 

• Click on the Unplaced Students tab   
 

 
 

• Click Auto Promote, then Fit All  

• Select Ignore students in off-grid sets and click OK 

• Click OK to accept changes and close the Move Students window 

 



 
Integris Timetable Construction   

Page 224 of 248 

© 2019 Civica Pty Ltd 
 

Allow Oversized Sets 

• Take a FULL Snapshot of your grid     
 

 
 

• Enter a Code and Description for your snapshot 
 

 
 

• Return to the Tools > Move Students > Unplaced Students  

• Select Allow Oversize Sets and then click on Fit All again. 

• Click OK to accept any changes and close the window 
 
 

Switch View > Vertical Grid View 

• Identify oversized sets 
 

 
 

• If the oversized set is too big, retrieve your snap shot by clicking  and selecting your 
snapshot 
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• Continue to attempt to place students and to balance sets 
 
Depending on your placement of teaching sets on the grid you may also wish to: 

• Add Teaching sets through the Tools menu 

• Delete Teaching sets through the Tools menu 

Note: You can revert to an earlier snapshot at any time. 

• Note the names of three unfitted students 

• Close Move Students 

• Lock  grid 

• Click Yes to save the changes 
 

 

6.22 Student Counselling 

Once a grid has been created, it may be necessary to counsel students regarding changes to their 
preferences to allow them a full study load within the constraints of the timetable and the resources 
of the school. 
 
After consultation with the student, it will probably be necessary to alter their preferences or 
promote reserve preferences and create a new timetable for the affected student.  This would 
usually be done through Timetabling > Student Courses.  The course for each student is presented 
in three views.  These are Preferences, Timetable and Grid.  Each view will allow the entry and 
editing of the student’s course and will have advantages in different circumstances.  The timetable 
view will only be available when the grid to which the student is a member has been saved to the 
timetable. 
 
To help in the counselling of students the Student Fit Report (Timetabling > Reports > Planning 
and Preparation Reports) may be of use.  
 

Preferences View 

 
 
Any preference that has not been assigned to a teaching set will be highlighted in red and have NO 
in the Assign column.  In order to fit a student to a grid, preferences may have to be added, 
deleted or promoted from Reserve. 
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To add preferences, click on Show/Hide Subject List to bring up the subject list.  Then click on 
the required subject and drag and drop it onto the student preferences window. 
 

To delete a preference, highlight it and click on Delete.  
 

To promote a preference, highlight it and click on the Toggle button.  
 

Fitting the Student into existing Teaching Sets 

• Highlight the unassigned preference 

• Click on Assign Teaching Set  

• Highlight the appropriate teaching set and click OK 
 

 

Note: If the teaching set cannot be assigned due to a conflict a warning message will be 
displayed. 

Alternatively, suggested Student Fit may be used.    The following screen will be displayed. 
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The Suggested Fit may be saved or cancelled. 

Timetable View 

The Timetable View displays the selected student’s course within the grid and timeslice selected.  
Right clicking on a period presents a number of options to manipulate the student’s course.  
 

 

Note: This view is only available once the grid has been saved as timetable. 

Grid View 

Grid View presents the selected student’s course overlayed onto the grid.  Right clicking on a 
populated cell enables the student to be removed or moved to an alternate teaching set.  A band or 
band record to which the student is not fitted is highlighted and the student can be added to a 
selected teaching set. 
 



 
Integris Timetable Construction   

Page 228 of 248 

© 2019 Civica Pty Ltd 
 

 
 
 

ACTIVITY 

Timetabling > Student Course 

• Find the unfitted students 

• Filter to 2020 

• Reassign the preferences of these students in your preferred view 

• Close  
 

 

6.23 Save as Timetable 

Timetabling > Grid Modelling > Functions > Save as Timetable 

Saving the grid as a timetable will incorporate the grid into the total overview of the school’s use of 
resources, that is, the timetable.  The action of saving locks the band records in the saved 
schedule into the grid.  Once the grid has been saved, it may not be re-modelled.  However, a grid 
may be unsaved if necessary and then may be re-modelled.  
 
Unlocking the grid, clicking on the Functions menu and choosing Save as Timetable from the 
menu will display the following screen.   
 

 
 
Highlight the grid to be saved and click the Save button. 
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ACTIVITY 

Save the Semesters 1 Year 8 and 9 grids to the timetable. 

Timetabling > Grid Modelling > Functions > Save as Timetable 

• Highlight the Term 1 for the Year 8 grid and Semesters 1 and 2 for the Year 9 grid  
 

 
 

• Click Save 

• Click Yes 

• Close the window and lock the grid 

• Click Yes you do wish to save 
 

 
  



 
Integris Timetable Construction   

Page 230 of 248 

© 2019 Civica Pty Ltd 
 

 

6.24 Allocating Staff and Rooms 

Allocate Staff and Rooms allows the user to indicate which teacher and room will be used for each 
occurrence of a teaching set on the timetable. 
 
Allocation and maintenance of staff and room details is performed within the Timetable.  Selection 
of this function will open the timetable that applies to the current date.  The timetabling year and 
timeslice can be selected to view the timetable to be staffed and roomed. 
 
Only grids that have been saved as timetable will be visible. 
 

 
 
Staff and rooms may be allocated to subjects on the timetable in one of three ways: 

• Manually placing staff and rooms for every occurrence of a teaching set on the grid 

• Auto-allocate all staff and rooms 

• Manually allocate staff and/or rooms for some teaching sets and then auto-allocate staff and/or 
rooms to the remaining teaching sets 
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6.24.1 Manual Placement of Staff and Rooms 

Teaching staff and rooms are allocated manually by highlighting an appropriate teaching set, right 
clicking and selecting from the list of functions. 
 

 
 

6.24.2 Auto-allocation of Staff and Rooms 

Auto-allocation of staff and rooms relies on subject-preferred rooms and staff preferred subject and 
rooms.  The auto-allocate staff and room function are available from the Function menu item 
within the Timetable. 
 

 

Auto-Allocate Staff 

The Auto Allocate Staff attempts to assign staff to all class meetings that are currently displayed 
in the Timetable window. 

Note That the Auto Staff Allocation function will only allocate staff to subjects in their list of 
preferences.  No allocations will be made where staff/subject preferences have not been 
made. 

If a set has been partially allocated to a single teacher, that teacher has the subject of the set in 
their list of preferences, and it can allocate the remaining meetings to the same teacher then it will 
allocate the remaining meetings to the same teacher. 
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If a set has no teacher allocations, it can be taught by a single teacher, and the teacher has the 
subject of the set in their preferences, then the teacher may be allocated to teach the set (this also 
takes account of preference rank).  It will do this first for staff who only have one subject 
preference, and then for remaining staff.  Over allocation of staff is not allowed at this stage (that 
is, staff will not be timetabled above specified Net FTE). 
 
If any class meetings remain to be allocated, then you will be asked if over-allocation of staff is 
allowed.  If it is then the previous step is repeated allowing over-allocation of staff. 
 
If a Combined Class has class meetings relating to two or more subjects, then a staff/subject 
preference for either subject will be sufficient for an allocation to be made.  Note that this means 
that some subjects may therefore be allocated to non-preferred staff. 
 
If a displayed class meeting is part of a Combined Class and is linked to a class meeting that is not 
displayed, then it will still attempt to allocate staff to the class meeting.  If successful then the 
allocation will apply to all class meetings that make up the Combined Class.  
 

Auto-Allocate Rooms 

The Auto Room Allocation will attempt to assign rooms to all class meetings that are currently 
displayed in the Timetable window.   

Note: The Auto Room Allocation function will only allocate rooms to subjects in their list of 
preferences.  No allocations will be made where room/subject preferences have not been 
made. 

Rooms are allocated to class meetings for a set where the set is already partially allocated to a 
single room, as long as all of the remaining meetings can be allocated to the same room. 
 
Sets that are linked to a room by a Must Have preference will be allocated to the Must Have room 
as long as the room can be used for all meetings of the set. 
 
Sets that are linked to a room by a positive preference (Highly Desirable, Desirable, Take if 
Necessary) will be allocated to an appropriate room as long as the room can be used for all 
meetings of the set.  This will take account of the rank of the preference. 
 
The previous step is repeated on an individual class-meeting basis – that is it does not check that 
all meetings of a set will be allocated to the same room.  Some meetings for a set may be allocated 
whilst others remain unallocated. 
 
Room allocation is then repeated on an individual class-meeting basis. 
 
Before proceeding, users will be asked if they wish to proceed or to skip room allocation on an 
individual class-meeting basis. 
 
If a Combined Class has class meetings relating to two or more subjects, then a room/subject 
preference for either subject will be sufficient for an allocation to be made.  Note that this means 
that some subjects may therefore be allocated to non-preferred rooms. 
 
If a displayed class meeting is part of a Combined Class and is linked to a class meeting that is not 
displayed, then it will still attempt to allocate rooms to the class meeting.  If successful then the 
allocation will apply to all class meetings that make up the Combined Class. For instance, if the 
Combined Class includes a Science class and a Maths class, and the Science class has Lab 1 as 
preferred room and Maths class has M1 as a preferred room, then if the auto room allocation 
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function is run with Maths classes only, it will select M1 for the Combined Class, whereas if the 
Science filter is applied then Lab 1 will be chosen. 
 

Staffing and Rooming Reports 

Some reports that may be of use are:  

• Period Summary  

• Teacher Clash Summary  

• Staff Load 

• Room Clash Summary Report 

• Room Load 
 

ACTIVITY 

Manually allocate Elizabeth Taylor to one of the English teaching sets on the 2020 
timetable   

Timetabling > Timetable  

• Open the 2020 timetable  

• Right click on an English class and from the menu select Allocate Teacher   

• Select Allocate Staff Member To All Class Meetings and click OK 
 

 
 
A list of preferred staff for the subject will be displayed. 
 

• Highlight Elizabeth Taylor and click OK 

Note that Elizabeth’s preferred room has also been allocated. 
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Auto-allocate staff and rooms for the remaining teaching sets for the Year 8 and 9 grids. 

• Click Functions   

• Select Auto-allocate staff  

• Click Yes twice 
 

• Click on Functions again and select Auto-allocate rooms  

• Click Yes twice 

Note: If there are teaching sets that cannot be allocated a teacher or room, users will be 
given the option to display an exception report to the screen (that may be printed).  These 
teaching sets may be allocated manually or constraints relaxed and the auto-allocate 
process run again. 

• Manually allocate teachers and rooms to classes still requiring them 
 

 

6.25 Lock Timetable 

ACTIVITY 

Timetabling > Timetable  

• Go to the Functions menu and click Lock Timetable 

• Enter your password and click OK 
 

 
 

• Click Yes 

• Close the timetable 
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7 Timetabling Reports 

The current timetabling reports are available from Timetabling>Reports.  Most reports are also 
available by printing of the relevant screens within the Timetabling module. The following list of 
reports may change in the future to meet the changing needs of users. Samples of the available 
reports may be viewed in Timetabling Manual. 
 
Timetabling Reports have been broken up into three areas: Data Validation, Planning and 
Preparation, and Operational and Maintenance. 
 

Data Validation Reports  

 
 
These reports allow the user to identify that correct subjects have been entered and allocated to 
the relevant students.  
 

Planning and Preparation Reports 

 
 
These reports assist the user in the planning and preparation of timetables. 
 

Operational and Maintenance Reports – Timetable 
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Operational and Maintenance Reports – Students 

 
 

Operational and Maintenance Reports – Staff  

 
 

Operational and Maintenance Reports – Rooms  

 
 

Operational and Maintenance Reports – Teaching Sets 
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ACTIVITY 

View the following reports 

Timetabling > Reports > Planning and Preparation Reports > Conflict Matrix 

• Select 2020, the Middle School and the 2020-09 grid 

• Use Find to select all Active Year 9 subjects 
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Timetabling > Reports > Planning and Preparation Reports > Staffing Requests 

• Check Combined Staffing Report 

• Enter 24 as the number of periods taught by a full-time teacher 

• Enter 4 as the number of periods in a standard unit 

• Print the report to the screen 
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Timetabling > Reports > O&M Reports-Students > Student Timetable by Date Range 

• Select 2020 

• Use Find to locate students currently in Years 7 and 8 whose surnames begin with A 

• Print the report to the screen 
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Timetabling > Reports > O&M Reports-Students > Student Course Information 

• Select 2020, the Middle School Campus and the 2020-09 Grid 

• Find three students 

• Print the report to the screen 
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Timetabling > Reports > O&M Reports-Staff > Staff Timetable 

• Select 2020 

• Use Find to locate some teachers 

• Print the report to the screen 
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Timetabling > Reports > O&M Reports-Teaching Sets > Teaching Set List (all Sets) 

• Select 2020 and the English Department 

• Print the report to the screen 
 

 
 

• Close the report 

• Select TS Headers only 

• Print the report to the screen again 
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8 Final Review 

ACTIVITY 

Where would you go to complete each of these tasks in the timetabling process?  

1. Set up the school year 
 
 
 
 
2. Add a new room type and room 
 
 
 
 
3. Edit a subject frequency 
 
 
 
 
4. Set up cohorts 
 
 
 
 
5. Edit staff preferred subjects 
 
 
 
 
6. Make members of staff available to a timetable cycle 
 
 
 
 
7. Set up a grid 
 
 
 
 
8.  Make subjects available to a grid 
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9.  Enter students’ preferences in bulk 
 
 
 
 
 
10.  Edit a subject load table 
 
 
 
 
 
11. Manually place teaching sets on the grid 
 
 
 
 
 
12.  Edit the inter-grid linkage table 
 
 
 
 
 
13.  Balance teaching sets 
 
 
 
 
 
14.  Map time slots to teaching periods 
 
 
 
 
 
15.  Save a grid to the timetable 
 
 
 
 
 
16.  Auto-allocate staff and rooms 
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9 Support 

Should you require support please contact the Customer Service Centre (CSC) at the 
Department of Education and Training. 
 
Contact details below: 
 

9.1 Phone (CSC) 

Metro: 9264 5555 
Country: 1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 
 

9.2 Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 
 

9.3 Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 

10 Online Manuals and Training Notes 

10.1 Civica Education 

Online manuals and training notes are available to download in PDF format from the Civica 
Education website. 
 
www.civicaeducation.com.au. 
 
Select online manual login. 
Username: school 
Password: help 
 

10.2 STIMS Project 

The Department’s Student Information Management Project (STIMS) website has numerous 
factsheets and support documents for all SIS Administration modules. 
 
http://www.det.wa.edu.au/intranet/stims  
 
Links to the Integris Manuals are also available from the STIMS website or by going to Help within 
Integris. 
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